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1 Introduction

1.1 About this document
This document describes the usage and configuration of the Edge
Gateways in the passive mode, i.e. the Edge Gateway receives data on
the OT interface and provides the received data for further processing via
OPC UA, Node-RED or Docker.

1.2 List of revisions
Revision Date Author Revision
1 2018-04-09 RG All sections created.

Table 1: List of revisions
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2 Passive process data acquisition with the Edge Gateway
This chapter
· compares the concepts of active and passive network diagnosis
· provides an introduction to the concept of the passive test access point
· introduces different circuitry variants with and without a test access

point and explains, when to use which one.
· presents the modes of operation of the Edge Gateway and the tool-

based configuration of the passive process data acquisition.
· presents various application scenarios (PROFINET, EtherCAT, custom-

value filters), for instance in order to adapt to other communication
systems or to select special frame characteristics.

· shows how to access to the captured process data within Node-RED or
via OPC UA.

· gives hints for improving the performance of analyzing and capturing
process data with the Edge Gateway.

· shows other sources of information about the passive process data
acquisition with the Edge Gateway

2.1 Introduction

2.1.1 Comparison of active and passive process data acquisition
Besides its usual function which has already been described in detail within
the preceding chapters, the Edge Gateway can also be used for passive
process data acquisition within the network.

At passive process data acquisition the Edge Gateway "listens" to the data
traffic of the connected field network (OT network) and captures it. by using
the passive mode, any interference with the field communication is
excluded as the Edge Gateway does not actively participate in the data
traffic within the field network.

There is a large amount of configuration settings and post processing
options which are mostly provided by the tool „Passive Fieldbus
Configurator". Configuration settings are provided by the tool „Passive
Fieldbus Configurator“.

Post-processing options are provided by Node-RED and OPC Ut.
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2.1.2 The Edge Gateway as test access point
A Test Access Point, abbreviated as TAP is an appliance (hardware or
software) used for the supervision of the network traffic at a specific
position within the network, where data shall be accessed for diagnosis.

Absence of feedback is the most important requirement for a test access
point.
The influence of a test access point to the network must be as small as
possible.

Due to its special function the Edge Gateway is located at a very central
position within the network, i.e. between the Master/Controller and the first
Slave/Device of the OT network and as well between the IT and the OT
network. Depending on the special application, another installation location
might also make sense.

A test access point for passive data acquisition can be implemented on two
different ways:
· As Software-TAP
· As Hardware-TAP

A software TAP is fully sufficient for many applications. As shown in the
following picture, in passive mode the Edge Gateway supplies such a
Software-TAP without requiring any additional devices

Figure 1: Edge Gateway as Software-TAP
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For the solution with Hardware-TAP, an additional device such as the
Ethernet mirror TAP netMIRROR NMR-TFE-RE from Hilscher (Part number
7340.100) is required. The following figure explains how to connect the
Hardware-TAP with the Edge Gateway:

Figure 2: Setup with Hardware-TAP

Note:
More information concerning the Ethernet Mirror TAP netMIRROR
NMR-TFE-RE can be found at the Hilscher-Website at https://
www.hilscher.com/de/produkte/produktgruppen/analyse-und-
datenerfassung/fuer-dauerhafte-installation/nmr-tfe-re/?.
Information on how to apply the netMIRROR with the Edge
Gateway is available at Hardware-based TAP
(netMIRROR) [} page 11].

Also see about this
2 Software-based TAP [} 9]
2 Hardware-based TAP (netMIRROR) [} 11]
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2.2 Application scenarios
Depending on aim and conditions of application, there are diffferent wiring
scenarios for the Edge Gateway in the passive mode.
· Software-based TAP:The Edge Gateway can directly integrated into

the OT network without any further devices. Usually, this is done
immediatetly behind the master/ Controller. This scenario is described
within Software-based TAP [} page 9].

· Hardware-TAP:The Edge Gateway can be applied in conjunction with a
hardware TAP, for example at strong demands on time delay or
absence of disruption of Master/Slave communication. If uninterrupted
operation at switched of state off the Edge Gateway or during
parameterization is required, this alternative must be chosen. This
scenario is described in Hardware-based TAP
(netMIRROR) [} page 11].

· Software-based TAP at the mirror port of a switch:The Edge
Gateway can also be used behind he mirror port of a switch. See
section Software-based TAP behind a mirror port [} page 13].

This section should help you to decide which application scenario is best
suited for your demands.
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2.2.1 Software-based TAP
This section describes the simplest application scenario of the Edge
Gateway, namely its use as a purely software-based TAP without use of
any additional devices.The following picture explains its principle of
operation.

Figure 3:  NIOT-E-TIJCX-GB-RE- Passive mode as software TAP

The advantages of this application scenario are:
1. SimplicityThis application scenario offers minimum effort in circuit

design .
2. No additional devices required.

In order to analyze the data traffic between IT and OT network, no
additional devices are necessary.

3. Small delay in time of communication in OT network („Fieldbus“). The
delay in time of the Ethernet frames caused by the software TAP
amounts less than 1 µs. Thus this scenario is suited for non-time-critical
applications where a delay in time of such an amount is tolerable.
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The following aspects are in disfavor of this application scenario:
1. When switching off or updating the Edge Gateway, the Ethernet

connection of the Fieldbus interface is interrupted.
2. Limited suitability for time-critical applications by limited absence of

delay: This application scenario is not absolutely free of delay. For
strongly time-citical applications, where a delay in time of the scale 1 µs
is not tolerable, this scenario is not suited.

3. Short-time link disruption possible when switching between
Configuration Mode and Operation Mode.
Take care of the following hints!

Important notes on the properties of the software TAP

Note:
If the software TAP provided by the Edge Gateway is directly used
without connecting a netMIRROR ahead in order to loop through
the Ethernet connection, then the Ethernet link can for a short time
be lost and established again when either switching between
Configuration Mode and Operation Mode or when connecting via
the netIOT Edge Passive Fieldbus Configurator Software to the
Gateway.
For a short time, the network link is interrupted leading to a short
time communication breakdown between the network participants
which might cause a restart of your plant as well. This can be
avoided by connecting to the Edge Gateway via a hardware TAP.

Note:
The Ethernet connection is interrupted at switching off the Edge
Gateway or updating its firmware. For possible consequences see
above.

You can avoid all of these disadvantages by connecting via a hardware-
based TAP such as the netMIRROR, see next section.

Edge Gateway NIOT-E-TIJCX-GB-RE | Passive Operating Mode
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2.2.2 Hardware-based TAP (netMIRROR)
This section describes the application scenario of the Edge Gateway in
conjunction with a hardware TAP. The only additional hardware you need is
the Ethernet Mirror TAP netMIRROR by Hilscher (Part number 7340.100).

At high demands on interruption-free operation, it makes sense to apply a
hardware TAP such as the Ethernet mirror TAP netMIRROR NMR-TFE-RE
from Hilscher as short-time link disruption and other back effects from the
Edge Gateway to the system are excluded for this application scenario.

If the requirements If the requirements concerning the absence of delay
(delay < 1 µs) or reaction of the test access point are very demanding, the
use of a hardware TAP such as the Ethernet mirror TAP netMIRROR NMR-
TFE-RE from Hilscher (Part number 7340.100) is strongly
recommended.the absence of delay (delay < 1 µs) and security (physical
data diode) of the test access point are very demanding, the use of a
hardware TAP such as the Ethernet mirror TAP netMIRROR NMR-TFE-RE
from Hilscher (Part number 7340.100) is strongly recommended.

For this solution, the delay in time amounts approx. 1 ns and is similar to
the physically possible minimum delay time.

The following figure illustrates the basic function of this application
scenario:

Figure 4:  NIOT-E-TIJCX-GB-REwith hardware TAP
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The advantages of this application scenario are:
1. Absence of delay: 

The delay in time of the signals which is caused by the hardware TAP
amounts roughly in the scale of 1 ns and is thus of the same dimension
as the physically caused minimum propagation time delay of the signals
(so called „Real-zero delay“). Thus this variant can practically be seen
as free of delay.
So this scenario is also suited for highly time-critical demands.

2. Absence of feedback: 
Under any condition, no unintended or intended intrusion of Ethernet
frames will take place. No change occurs within the contents of data
packets.

3. No short-time link disruption
When using a hardware TAP, no problems caused by short-time link
disruption may occur like those which might occur within a pure
software TAP solution, see Software-based TAP [} page 10].Especially,
switching between configuration and operation mode or changes of the
TAP settings of the passive fieldbus will not cause any short-time link
disruption.

4. The Ethernet connection is not interrupted at switching off the Edge
Gateway or updating its firmware.

Note:
When using the Edge Gateway in the passive mode with hardware-
based TAP the speed of the network interface should be adjusted to
a fixed value of 100 Mbit/s. This minimizes the link-up time. See
Communication settings in the Passive Fieldbus Configurator.
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2.2.3 Software-based TAP behind a mirror port

Figure 5:  NIOT-E-TIJCX-GB-RE - Passive mode as software TAP at the morror port of a
switch

For PROFINET there is another application option by connecting the NIOT-
E-TIJCX-GB-RE with the mirror port of a switch. See following figure.

Note:
Do not use this option in conjunction with EtherCAT.

Edge Gateway NIOT-E-TIJCX-GB-RE | Passive Operating Mode
DOC180201UM01EN | Revision 1 | English | 2018-04 | Released | Public

© Hilscher 2018



Passive process data acquisition with the Edge Gateway 14/143

2.3 Configuration for passive mode
This section introduces the basic modes of operation of the Edge Gateway
concerning passive process data acquisition and explains the differences
between these. Additionally, it shows, how configuration files for passive
process data acquisition can be created and then loaded into the Edge
Gateway and explains important settings for instance concerning
communication and OPC-UA.

2.3.1 Modes of operation
In the following, the basic modes of operation of the Edge Gateway
concerning passive process data acquisition are introduced and the
differences between these are explained.
· Passive, inactive and active mode of operation
· Properties of the three modes of the passive mode

These can be set using menu entry Network-Field of the Control Panel.

2.3.1.1 Operating modes

The mode of operation of the Edge Gateway can be switched within the
Control Panel. This is done within menu entry Field of the Network menu.

Active mode of operation

In the active mode of operation, the Edge Gateway couples an automation
network (OT network) to an external network, a cloud or an IoT
application.Within the automation network, the Edge Gateway represents a
slave device, i.e. it cyclically exchanges data with a PLC. This slave device
sends and receives process data over the fieldbus. The PLC program
must be adapted accordingly. Another important function of the Edge
Gateway is to provide various extensive security mechanisms in order to
protect the automation network against attacks from outside.

If the Edge Gateway is in the active mode of operation then menu entry
Network > Field within the Control Panel is displayed as follows:

Figure 6: Active mode of operation

Within Node-RED, the fieldbus input node and the fieldbus output node
provide a means for coupling the automation network in active mode of
operation .
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Inactive mode of operation

In the inactive mode of operation, the field interface (Ethernet interface to
the automation network (OT network)) is deactivated in both data flow
directions, i.e.neither sending nor reception of data packets will take
place.

The inactive mode of operation is the standard mode of operation of the
Edge Gateways (the default mode of operation).

If the Edge Gateway is in the inactive mode of operation, the menu entry
Network > Field within the Control Panel is displayed as follows:

Figure 7: Inactive mode of operation

Passive Operation Mode

In Passive Operation Mode, you can use the Edge Gateway as a passive
device in the automation network only. Process data is received from the
fieldbus network from other field devices only. The device does not send
any process data. A modification of the PLC program is not necessary,
because the Edge Gateway is working passive in the fieldbus network.

In the Passive Operation Mode, the automation network is protected
against attack from “outside”. How the Edge Gateway works in detail in the
Passive Operation Mode depends on the signal configuration which is done
largely by a configuration file created with the GUI-based tool Passive
Fieldbus Configurator.

Is the Edge Gateway in the Passive Operation Mode, then the Network >
Field menu in the Control Panel shows:

Edge Gateway NIOT-E-TIJCX-GB-RE | Passive Operating Mode
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Figure 8: Passive Operation Mode - Operational mode

Access with Node-RED

In the Active Operation Mode, the fieldbus input node and the fieldbus
output node have to be used to cconnect to the automation network. In the
Passive Operation Mode, these nodes cannot be used. The
passivefieldbus input node has to be used instead to connect to the
automation network.
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Switching between the modes of operation

In order to switch to the intended mode of operation, proceed as follows:
Ø Select the intended mode of operation within the selection list in the

Operation mode.

Figure 9: Example: Switching to active mode of operation

Ê The display on the screen changes according to the newly selected
mode of operation.

Ø Click at Change mode.
Ê A safety query is displayed and informs you about the restart of the

Node-RED service. If switching to the active mode of operation, this
safety query also informs you about the loading of the desired firmware.

Ø At the confirmation prompt answer with Yes.
ð The following message text appears on a light green background: The

field operating mode is successfully changed.

Note:
In any case, the Node-RED service on the Edge Gateway is
automatically restarted, when switching between the various modes
of operation.

2.3.1.2 Properties of the three modes of the passive mode

In passive mode of operation, there is the option to select between the
Configuration mode, the Operational mode and the Docker mode. These
have the following meaning:

Configuration mode

This mode is intended for configuration of the passive mode of operation of
the Edge Gateway. it allows the Passive Fieldbus Configurator to connect
to the Edge Gateway in order to interactively detect and select the available
process data signals.

In Configuration mode, the TCP/IP Port 50111 on the Edge-Gateway is
opened to enable device access by the Passive Fieldbus Configurator. As
long as the Configurationmode is selected, no data are passively
acquired.

Operational mode

This mode has been designed for passive data acquisition with evaluation
of the acquired data either using Node-RED or using OPC UA. Changes of
the signal configuration cannot be accomplished within this mode.

Edge Gateway NIOT-E-TIJCX-GB-RE | Passive Operating Mode
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Docker mode

This mode allows you to analyse the (passive) process data using an
application running the a docker container. Changing the signal
configuration is not possible in this mode.

The subsequent table explains the properties and differences of the three
modes of the passive mode of operation of the Edge Gateway.
Criterion/ mode Configuration Operational Docker
Change of configuration Allowed Prohibited Prohibited
State of the OPC UA server Inactive Active Inactive
State of TCP/IP-Port 50111 Open Closed Closed
Access to Docker Prohibited Prohibited Allowed

Table 2: Properties of the three modes of the passive mode

In order to set the operation mode
Ø Within the Control Panel select menu entry Network>Field.
Ê The configuration screen is displayed.
Ø Select the intended mode of operation (Configuration, Operational or

Docker) of the passive mode of operation in selection list „Mode“. That
list is located in the Passive area within the configuration screen. The
subsequent figure provides an example for the switching from mode
Configuration to mode Operational:

Figure 10: Switching from mode Configuration into the mode Operational of the passive
mode (example: swiching from Configuration to Operational).

Ø Click at Change mode.
Ø A message window is displayed and informs about the consequences of

the mode selection which depend from the slected mode).

Figure 11: Message window when switching to operational mode in passive mode of
operation

Ø The message window contains a safety query. Answer it with Yes.
ð The message box is closed then.
ð The following message text appears on a light green background:

Passive mode is successfully changed. The mode is being changed.
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In this mode the configuration cannot be changed.The data acquisition is
running and provides the acquired process data signals via OPC UA or
Node-RED (depending on the signal configuration).

2.3.2 Configuration parameters and project files
There are two different kinds of configuration parameters in passive
process data acquisition with the Edge Gateway. The definition of the
process data signals is stored in configuration files, that you can create and
edit using the tool „Passive Fieldbus Configurators“.

This section shows, how you can create detailed configuration files for
passive process data acquisition using the tool „Passive Fieldbus
Configurator“ and then upload these files into the Edge Gateway. OPC UA-
and Node-RED specific parameters are displayed or directly set in the
Control Panel or in the Node-RED node.

2.3.2.1 Working with project files

Project files are created and edited using the Passive Fieldbus
Configurator. They contain the configuration information for the passive
mode of the Edge Gateway. The file extension for project files of the
passive fieldbus configurator is *.fbcfg.

How to create project files is in detail described within the extensive
application examples, see Use Cases [} page 28].

Upload

In this context, upload means data transfer of project files from the file
system of the computer running the Control Panel to the Edge Gateway.

The following requirement applies for the upload of a project: The Edge
Gateway is in the passive mode of operation and the mode „Configuration“
is active.

In order to upload project files, click at button Upload in the area Signal
Configuration of control panel page Network->Field.

Figure 12: Button "Upload" (part of the configuration page within the control panel)
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Download

In this context, download means data transfer of project files from the Edge
Gateway to the file system of the computer running the Control Panel.

The following requirement applies for the download of a project: The Edge
Gateway is in the passive mode of operation and the mode „Configuration“
is active.

In order to download a project file, click at button Download in the area
Signal Configuration of control panel page Network->Field.

Figure 13: Button "Download" (part of the configuration page within the control panel)

Deleting project files

The following requirement applies for the deletion of project files: The Edge
Gateway is in the passive mode of operation and the mode „Configuration“
is active, see Mode "Configuration".

Only delete project files if you are absolutely sure that you do not need
these files any longer. In order to be able to restore the project file, it is
generally recommended to download project files to your PC before
deleting them

In order to delete project files just click button Remove in the area Signal
Configuration of control panel page Network->Field.

Figure 14: Button "Remove" (part of the configuration page within the control panel)
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2.3.2.2 OPC-UA settings within the Control Panel

Figure 15: OPC-UA settings within the Control Panel, page Network>Field

In the Control Panel (OPC UA Server for Edge Settings in the service list),
the following settings for OPC UA are possible:

Communication settings

The following basic communication settings can be applied:
Field name Meaning Comment
Port The port used by OPC-UA

for communication
Numeric field
Range of values: integer values, >=0
Default: 100

Server name The name of the OPC UA
server

Text field

Global Discovery
server URL

URL of the server Text field
Default:
opc.tcp://127.0.0.1:4840/
UADiscovery

Table 3: Input fields for communication settings of the OPC UA Server for Edge
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Limitation settings

The following limitation settings are possible in the Limitations area:
Field name Description Remark
Max Sessions Maximum number of sessions Numeric field.

Range of values: integer, >=0
Default: 10

Max connections per
endpoint

Maximum number of
connections per endpoint

Numeric field.
Range of values: integer, >=0
Default: 100

Max nodes per read Maximum number of nodes
per read

Numeric field.
Range of values: integer, >=0
Default: 100

Max nodes per browse Maximum number of nodes
per browse

Numeric field.
Range of values: integer, >=0
Default: 200

Min sampling interval
Edge Server

Minimum sampling interval of
the Edge Server, in
milliseconds

Numeric field.
Range of values: integer, >=0
Default: 1000 milliseconds

Min sampling interval
passive fieldbus

Minimum sampling interval of
the passive fieldbus, in
milliseconds

Numeric field.
Range of values: integer, >=0
Default: 100 milliseconds

Table 4: Input fields for limitation settings of the OPC UA Server for Edge

Security settings

The following security settings are available:

Security modes: The following options apply:
· Checkbox None
· Checkbox Sign
· Checkbox Sign&Encrypt

Security policies: The following options apply:
· Checkbox None
· Checkbox Basic128Rsa15
· Checkbox Basic256

Option Anonymous access

In order to allow anonymous access, click at checkbox Allow anonymous
access.

Settings for the Passive Operation Mode

The checkbox Enable passive fieldbus the OPC UA Server for the
passive operation mode.
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Connection settings

Here you can specify via which username and which password all
connections of the OPC UA Server will be established.
Fieldname Meaning Comment
Username Username for all connections of the OPC UA

Server
Text field

Password Password for all connections of the OPC UA
Server

Text field

Table 5: Input fields for settings concerning connection establishment of the OPC UA Server
for Edge

Storing the settings for the OPC UA Server for Edge

After you finished making yor settings for the OPC UA Server for Edge, you
have to store these as follows in order to make them effective.
Ø Click at Save all.
Ê The following message box appears:

Figure 16: Safety query when storing the OPC UA Server configuration

Ø Click at OK.
ð The following message appears:

OPC UA config settings are successfully saved
The changes are stored in the Edge Gateway now. However, they will
get effective after the next restart of the Edge Gateway.
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3 Licensing
This section describes, what you should know about the usage of licenses
if you intend to work with the Edge Gateway in the passive mode of
operation. For the operation of the Edge Gateway in passive mode you
require a special license, the netIOT Passive Fieldbus Integration License.

3.1 License overview
The functionality of an Edge Gateway can be extended. The following table
lists functional extensions, for which a license is required to use those.

License name Product Part number Description
netIOT Passive Fieldbus
Integration License

NIOT-S-LIC-SNIF 1350.030 The Edge Gateway can be used in passive mode. In
the passive mode, the Edge Gateway receives data on
the OT interface and provides the received data for
further processing via OPC UA, Node-RED or Docker.

Table 6: License overview
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3.2 Which licenses are present in the device?
In order to display the licenses contained in the Edge Gateway, use the
License Manager. You can open it as follows:
Ø Open the Control Panel.
Ø Select System>License Manager.
Ê The window of the License Manager opens:

Figure 17: License Manager with license for the passive mode of operation

The table License enabled Software Packages displays the currently
available licenses, in the example a license for the passive mode of
operation of the Edge Gateways is available.

Open Details window in the License Manager

To open the Details window:
Ø Click at the info button on the left edge of the line (within column

Details ).
Ê The Details window opens:

Figure 18: License information in window Details

For each license, it displays the license type (Column Type), a brief
description (Column Description) and the expiration date (Column
Expires) .
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3.3 How to order and receive a license
The following instruction explains how to order a license for your Edge
Gateway to be used in passive mode of operation and receive a license file.

If you order device and license together or after ordering the license, you
receive a delivery note. After receiving the delivery note order the license
file from Hilscher by e-mail. Specify the following information in your e-mail:
1. The denomination of the desired license
2. The number of your delivery note (for reference)
3. The LAN MAC address of your device (to be taken from the device

label)
4. The e-mail address, to which the license download link shall be sent to.

Specify the following as the subject of your e-mail:

Request for a netIOT Licence

Ø Send the e-mail to Hilscher: vertrieb@hilscher.com
Ø Hilscher creates an individual license file for your Edge Gateway

according to the information supplied by you.
Ø Hilscher sends this file back to you as an attachment within the answer

e-mail. Consequently, this license file has to be transferred into the
Edge Gateway as described in section How to transfer a license into the
device? [} page 27].
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3.4 How to transfer a license into the device?
Load the individual license file received from Hilscher from your PC into the
Edge Gateway. Do the upload as follows:
Ø Open the Control Panel in a web browser.
Ø Select System > License Manager.
Ø Click on Upload License.
Ê A file selection dialog opens.
Ø Select the license file. This file has the file extension *.LIC.
Ø Click on OK.
Ê The license file is transferred into the Edge Gateway. If the transfer is

successful, the following message is displayed:

Figure 19: Message after the transfer of the license file into the Edge Gateway

Ê To activate the license, a restart of the Edge Gateways is necessary.
Ø Click on OK.
Ê The license is installed now, but becomes active after the next restart of

the Edge Gateways.
Ø For a restart, select System > Reboot.
ð The license is activated.
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4 Use Cases
This section describes in step-by-step descriptions for the communication
systems PROFINET and EtherCAT, how you can automatically or manually
commission the passive process data acquisition with the Edge Gateway.
Furthermore, it explains using the example of Powerlink, how you can use
custom-value filters for the recognition and acquisition of specific Ethernet-
Frames, such as Ethernet-Frames of other Industrial Ethernet systems or
other special Ethernet frame types.

4.1 PROFINET (automatic)
By the means of a step-by-step instruction, this section describes the
commissioning of the passive process data acquisition with the Edge
Gateway in PROFINET networks with automatic recognition of PROFINET
devices during the start-up of PROFINET.

The following figure shows the wiring diagram related to this step-by-step
instruction. In this context, the Edge Gateway is wired as passive access
point into the communication between the PROFINET IO-Controller and the
IO-Devices in order to capture it completely.

Figure 20: Application example: passive process data acquisition with the NIOT-E-TIJCX-
GB-RE in PROFINET networks
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In the following description nine steps explain how you can create a project
file for passive process data acquisition with the Edge Gateway in your
PROFINET- network (Steps1 to 8) and upload this project file into the Edge
Gateway then (Step9, see separate description Uploading the project file to
the Edge Gateway [} page 113]).

Prerequisites for the automatic generation of a project file for
PROFINET

The following prerequisites have to be met:
1. The Edge Gateway is in the passive mode of operation and the

Configuration Mode is active.
Otherwise, the assignment of the IP address in step 3 (see below) is not
possible.

2. The software Passive Fieldbus Configurator must be installed on a
PC, from which network access to the Edge Gateway can be
accomplished. If this is not the case, install the softweare according to
the installation instructions in the documentation of the Passive Fieldbus
Configurator (Document number DOC171103OI01EN).

3. The IP adress of the Edge Gateway must be known.
4. For all devices in your PROFINET network suitable GSDML files

should be available. Otherwise additional manual configuration effort
will be necessary.

4.1.1 Step 1 - Start the Passive Fieldbus Configurator.
Ø Start the Passive Fieldbus Configurator on your PC, for example via the

entry netIOT – Passive Fieldbus Configurator in the Windows start
menu or by double-clicking at the icon netIOT - Passive Fieldbus
Configurator.

ð The entry screen of the Passive Fieldbus Configurator is displayed:
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4.1.2 Step 2 - Creating an empty project
Ø Build a new project within the Passive Fieldbus Configurator by

selecting Create->New within the introductory menu..
Ê The GUI of the Passive Fieldbus Configurator is displayed.

Figure 21: Empty GUI of the Passive Fieldbus Configurator
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4.1.3 Step 3 - Adjust basic settings of the Passive Fieldbus Configurator.
The Passive Fieldbus Configurator requires the following basic settings:
· Setting of IP address
· Setting ofSetting of network speed

To do so, proceed as follows:
Ø Open the main menu. in order to do so, click at button Menu within the

side menu located at the right side.

Figure 22: Side menu

Ê The main menu is opened.

Figure 23: main menu - Register card "Views"
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Ø Select the register card Device assignment.

Figure 24: main menu - Register card "Device assignment"

In order to establish a connection with the Edge-Gateway, the IP address of
the Edge-Gateway must be assigned to the software. This reqires the
Gateway being in the passive mode of operation. Proceed as follows:
Ø Select the IP addresss of the Edge-Gateway to connect with from the

selection list IP Address in the device selection area. If this list is still
empty yet or the IP address of the Edge Gateway is missing in it,
specify the IP address within the input field or click at the cog wheel

symbol  at the right and specify the IP address in the dialog box
which will appear. This IP address must comply with the valid rules for
specifying IP adresses.

Ø Click at .
Ê Finally, the connection with the according Edge Gateway has been

established.

As described in the following, you can check whether a connection to the
Edge Gateway has been established:
1. In the field Firmware Version the version number of the currently

installed firmware of the Edge Gateway is displayed.
2. The status display in the right part of the lower status bar of the Passive

Fieldbus Configurator changes from blue indicating status Idle to yellow
indicating status Stopped.

3. In the left part of the status bar now statistic information concerning the
Ethernet data traffic and zthe interface configuration are displayed.

4. The formerly grayed ot menu entry Connect is activated.
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Otherwise the following error message will appear:

Figure 25: Error message "The connection to the device was not possible"

The most probable cause of this error message is the Edge Gateway not
being in the configuration mode of the passive mode of operation!

Note:
For more information concerning the solution of this problem see
section Error handling [} page 116].

Ø In order to adjust the network speed, select the network speed from the
selection list Network speed in the area TAP configuration

Figure 26: Selection list Network speed

For the network speed, the following settings are applicable:
Setting Meaning
Auto Automatic determination of network speed

Select this option if using the Edge Gateway as Software TAP.
Possible value
are Auto, 10
MBit/s and 100
MBit/s.

Fixed network speed of 100 Mbit/s
Select this option if working with an additional Hardware TAP.

Table 7: Settings for network speed
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4.1.4 Step 4 - Loading the GSDML files
You can select PROFINET as network to be captured within the Passive
Fieldbus Configurator and load GSDML files containing the device
descriptions of your connected PROFINET IO-Devices:
Ø Right-click at Netzwerk (Tap A).
Ê The context menu is opened.

Figure 27: Context menu at network level

Ø Select entry Edit network there.
Ê The network wizard is opened.

Figure 28: Network wizard

Ø Within the network wizard, select PROFINET as network protocol within
selection list Network protocol.

Figure 29: Selection list Network protocol.
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Ø Click at Finish.
Ê Thus, PROFINET has been selected as network protocol.

Figure 30: Import of device descriptions.

Ø Within the item list, click at Import (right of device descriptions). 
Alternatively, you can point at Network (Tap A) with the mouse pointer
and right-click there.

Ê A dialog for the selection of the GSDML file is displayed.
Ø Within this dialog, select one or more GSDML files describing your

PROFINET devicews.
ð The device descriptions contained within the GSDML file are imported

and the contained items are integrated into the structure tree within the
Passive Fieldbus Configurator.

Figure 31: Imported device description within the item list of the Passive Fieldbus
Configurator (Example)
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4.1.5 Step 5 - Acquiring the start-up of PROFINET communication
Some information relevant for the Edge Gateway and required for its
configuration is not contained within the GSDML files of PROFINET. This
applies for instance to the MAC addresses of the devices or the FrameID
identification of the PROFINET frames. In order to avoid manual acquisition
of this information, the Passive Fieldbus Configurator provides the
possibility to acquire this information automatically during start-up of
PROFINET communication between IO-Controller and IO-Devices with the
Edge Gateway.

In order to supervise the start-up phase of the PROFINET configuration you
first have to put the Gateway and the Passive Fieldbus Configurator into
recording mode . This must be accomplished prior to starting the
PROFINET configuration. You can achieve this as follows:
Ø Within the side menu of the Passive Fieldbus Configurators (right side)

aclick at Connect

:.
Ê Now the start-up phase of the PROFINET communication is supervised.

The status within the display in the status bar below changes from
Stopped (yellow) to Started (green). The menu entries "Start" and
"Disconnect" in the side menu are activated.

Explanation:After successful creation of the connection, the Edge
Gateway waits for the connect request and connect response of the
PROFINET connection. During the start-up phase of the PROFINET
communication, the Edge Gateway supervises the data traffic between the
Controller and the Devices. This process may last some seconds. Yet after
completion , the Passive Fieldbus Configurator is able to identify the
PROFINET-IO-Controller- and PROFINET-IO-Devices within the network
and to display these in the item list.
If the button Connect has been grayed out, the connection to the Edge
Gateway could not be configured correctly. In this case, try again to
configure the connection according to step 3.
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4.1.6 Step 6 - Signal configuration
In order to activate a signal, proceed as follows:
Ø Within the Passive Fieldbus Configurator, drag the signal from the

element list window into the window „Signal configuration“.
Ê In window "Signal configuration", a new entry with the name of the

signal is displayed There you can also decide whether the processing of
this signal shall be continued by transferring it to OPC UA or Node-
RED.

Note:
In order to reduce CPU time and memory consumption on the Edge
Gateway only choose those methods for continuation of processing,
which you really need in your specific application.

Ê The entry with the name of the signals within the element list still
remains there, but it is now protected against editing and erasure, i.e.
the respective context menu functions are grayed out and deactivated.

Figure 32: Window "Signal configuration" of the Passive Fieldbus Configurator.

Ø Configure the signals in the window Signal configuration of the
Passive Fieldbus Configurator. By checking you can decide easily for
each single signal whether the acquired data shall be fetched from the
Edge Gateway by OPC UA or shall be made available within Node-
RED.
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4.1.7 Step7 - Check Signals in the Live-Data View
This step is optional. Viewing signals within a live-data window is
recommended if you want to check whether a specific signal has been
configured correctly .

Proceed as follows:
Ø Within the side menu of Passive Fieldbus Configurator (right side), click

at button Start.
Ø Drag all signals intended to be viewed in the window Live Data one by

one with the mouse button pressed down from the element list into the
right part Buckets of the Live Data window.

Ê The data acquisition within the Passive Fieldbus Configurator has been
started. In the Live View window you can watch the signals and tune
your configuration if necessary.

4.1.8 Step 8 - Storing the generated configuration file (PROFINET)
Ø Create a configuration file (i.e. a project file) for your PROFINET project

using the Passive Fieldbus Configurator. Store this file via Project >
Save within the main menu before finishing working with the Passive
Fieldbus Configurator .

ð You have now created a project file for the configuration of your
PROFINET network within the passive mode of the Edge Gateway. In
section Uploading the project file to the Edge Gateway [} page 113]
uploading of this file onto the Edge Gateway and activating it is
described.
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4.2 PROFINET (manual)
If there is no possibility to record the start-up phase of PROFINET., the
devices can also be configured manually. By the means of a step-by-step
instruction, this section describes the commissioning of the passive process
data acquisition with the Edge Gateway in PROFINET networks with
automatic recognition of PROFINET devices during the start-up phase of
PROFINET.

For the manual configuration no network connection between configurator
program and Edge Gateway is required contrary to the automatic
configuration. However, the following requirements must be fulfilled:
· The software Passive Fieldbus Configurator must be installed on a PC,

from which network access to the Edge Gateway can be accomplished.
If this is not the case, install it according to the installation instructions.

· For all devices in your PROFINET network suitable GSDML files should
be available. Otherwise additional manual configuration effort will be
necessary.

The following figure shows the wiring diagram related to this step-by-step
instruction. In this context, the Edge Gateway is wired as passive access
point into the communication between the PROFINET IO-Controller and the
IO-Devices in order to capture it completely.

Figure 33: Application example: passive process data acquisition with the NIOT-E-TIJCX-
GB-RE in PROFINET networks
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In the following description nine steps explain how you can create a project
file for passive process data acquisition with the Edge Gateway in your
PROFINET network (Steps 1 to 8) and upload this project file into the Edge
Gateway then (Step 9, see separate description Uploading the project file
to the Edge Gateway [} page 113]).

4.2.1 Step 1 - Start the Passive Fieldbus Configurator.
Ø Start the Passive Fieldbus Configurator on your PC, for example via the

entry netIOT – Passive Fieldbus Configurator in the Windows start
menu or by double-clicking at the icon netIOT - Passive Fieldbus
Configurator.

ð The entry screen of the Passive Fieldbus Configurator is displayed:

4.2.2 Step 2 - Creating an empty project
Ø Build a new project within the Passive Fieldbus Configurator by

selecting Create->New within the introductory menu..
Ê The GUI of the Passive Fieldbus Configurator is displayed.

Figure 34: Empty GUI of the Passive Fieldbus Configurator
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4.2.3 Step 3 - Adjust basic settings of the Passive Fieldbus Configurator
The Passive Fieldbus Configurator requires the following basic settings:
· Setting of network speed

To do so, proceed as follows:
Ø Open the main menu. in order to do so, click at button Menu within the

side menu located at the right side.

Figure 35: Side menu

Ê The main menu is opened.

Figure 36: main menu - Register card "Views"

Ø Select the register card Device assignment.

Figure 37: main menu - Register card "Device assignment"
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The main menu of the Passive Fieldbus Configurator consists of two areas:
· the area Device selection (top)
· the area TAP Configuration (down)

The network speed is selected in the area TAP configuration
Ø In order to adjust the network speed, select the network speed from the

selection list Network speed in the area TAP configuration

Figure 38: Selection list Network speed

For the network speed, the following settings are applicable:
Setting Meaning
Auto Automatic determination of network speed

Select this option if using the Edge Gateway as Software TAP.
Possible value
are Auto, 10
MBit/s and 100
MBit/s.

Fixed network speed of 100 Mbit/s
Select this option if working with an additional Hardware TAP.

Table 8: Settings for network speed
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4.2.4 Step 4 - Loading the GSDML files
You can select PROFINET as network to be captured within the Passive
Fieldbus Configurator and load GSDML files containing the device
descriptions of your connected PROFINET IO-Devices:
Ø Right-click at Netzwerk (Tap A).
Ê The context menu is opened.

Figure 39: Context menu at network level

Ø Select entry Edit network there.
Ê The network wizard is opened.

Figure 40: Network wizard

Ø Within the network wizard, select PROFINET as network protocol within
selection list Network protocol.

Figure 41: Selection list Network protocol.
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Ø Click at Finish.
Ê Thus, PROFINET has been selected as network protocol.

Figure 42: Import of device descriptions.

Ø Within the item list, click at Import (right of device descriptions). 
Alternatively, you can point at Network (Tap A) with the mouse pointer
and right-click there.

Ê A dialog for the selection of the GSDML file is displayed.
Ø Within this dialog, select one or more GSDML files describing your

PROFINET devicews.
ð The device descriptions contained within the GSDML file are imported

and the contained items are integrated into the structure tree within the
Passive Fieldbus Configurator.

Figure 43: Imported device description within the item list of the Passive Fieldbus
Configurator (Example)
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4.2.5 Step 5 - Manual configuration of PROFINET IO-Controller and -
Devices

All devices of the PROFINET network (PROFINET IO-Controller and IO-
Devices) must now be configured manually. Proceed as follows:

Configuring Controller / IO-Controller

The element IO-Controller is the root element of the configuration tree.
Therefore, it is the first element of this tree to be configured. Proceed as
follows:
Ø Open the context menu. Right-click at Configuration within the element

list.
Ê The context menu appears.

Figure 44: Context menu entry “Add controller”

Ø Choose the only menu entry Add controller.
Ê The controller assistant is opened:

Figure 45: Controller assistant
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Ø Enter the name of your PROFINET IO-Controller into the field Name.
This field is mandatory.

Ø Enter the MAC address of the PROFINET IO-Controller into field Name.
This field is mandatory.

Ø Click at Finish.
ð Now, the controller is configured.

Configuring Device / IO-Device

One or more IO devices are subordinated to an IO controller. In order to
configure these, proceed as follows:
Ø Open the context menu. Rightclick at the IO controller within the

element list
Ê The context menu appears.

Figure 46: Context menu entry "Add device"

Ø Select the entry Add device
Ê The device assistant is opened:

Figure 47: Device assistant
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Ø Enter the name of the device (NameOfStation) into the field Name. The
device name must be unique within the network. This field is mandatory.

Ø Enter the Device ID into the field Device ID. The Device ID is a unique
identification number for the device. This field is mandatory.

Ø Enter the Manufacturer ID into the field Manufacturer ID. The
Manufacturer ID is a unique identification number which is assigned to
the manufacturer by the PNO , 
This field is mandatory.

Ø Enter the MAC address of the device into the field MAC address. The
MAC address consists of six two-digit hexadecimal values separated by
colons. This field is mandatory.

Ø Click at Finish.
ð Now, the IO device is configured.

To configure a module within the device configuration, perform the following
steps:

Configure module

One or more modules are subordinated to a device. In order to configure
these, proceed as follows:
Ø Open the context menu. Rightclick at the IO Device within the element

list
Ê The context menu is opened.

Figure 48: Context menu entry "Add module"
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Ø Select the entry Addodule
ð The module assistant is opened.

Figure 49: Module assistant

Ø Specify the desired name of the module in the field Name. This name
can freely be chosen, however, it may not be empty.

Ø Specify the identification number of the module of your PROFINET
device in the field Identification number either in decimal format in the
left input field or in hexadecimal format in the right input field..

Ø Specify the slot number in the field Slot number either in decimal
format in the left input field or in hexadecimal format in the right input
field..

Ø The other fields are optional. 
You can specify the order number in field Order number. 
An additional descriptive Text can be specified in field Infotext.

Ø Click at Finish.
ð Now, the module is configured.

To configure a submodule within the device configuration, perform the
following steps:
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Configure submodule

One or more submodules are subordinated to a module.
Ø Open the context menu. Rightclick at the module within the element list.
Ê The context menu is opened.

Figure 50: Context menu entry "Add submodule"

Ø Select the entry Add submodule
ð The submodule assistant is opened.

Figure 51: First page of dialog "Submodule assistant".

Ø Specify the desired name of the submodule (subslot) in the field Name.
Ø Specify the identification number of the submodule of your PROFINET

device in the field Identification number either in decimal format in the
left input field or in hexadecimal format in the right input field..
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Ø Specify the subslot number in the field Subslot number of your
PROFINET device either in decimal format in the left input field or in
hexadecimal format in the right input field..

Ø Specify whether the submodule holds input and/or output values by
checking the according checkboxes and specify the according data
length in bytes.

Note:
At least one of the two input fields Input data length and Output data
length must be checked. For submodules working bidirectionally,
both directions have to be selected.

Ø Specify the length of the IOCS byte within the field IOCS byte length
either decimally in the left input field or hexadecimally in the rightinput
field.

Ø Specify the length of the IOPS byte within the field IOPS byte length
either decimally in the left input field or hexadecimally in the rightinput
field.

The following specification is optional.
Ø Here you can specify additional info text.

In order to proceed to the second page of the submodule assistant,click at
Continue.
The following dialog appears:

Figure 52: Second page of dialog "Submodule assistant".

This page offers the possibility to specify the following parameters
concerning the frame configuration:

The selection list Frames enables specifying of multiple process data
frames, for instance one for the each data direction (input and output) at
bidirectional submodules.
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By clicking at the green plus symbol it is possible to specify information for
an additional frame. Vice versa, the currently selected frame wiothin the list
can be deleted with all related information by clicking at the "trashcan"
symbol.

For each frame, the following frame-related information can be stored here:
Ø Specify a freely selectable name for the frame in field Name. The

default name to be used when a new frame is generated is Empty
Frame.

Ø Specify the frame ID in the field Frame ID either in decimal format in the
left input field (Range of values 0…65535) or in hexadecimal format in
the right input field (Range of values 0…0xFFFF).

Ø Specify te data direction of the frame in field Frame direction. You can
select between these frame directions:

· Input
· Output
Ø Specify the offset of the data byte in field Data byte offset either

decimally in the left input field (Range of values 0…65535) or
hexadecimally in the right input field (Range of values 0...0xFFFF).

Ø Specify the offset of the IOCS byte in field IOCS byte offset either
decimally in the left input field (Range of values 0…65535) or
hexadecimally in the right input field (Range of values 0...0xFFFF).

Ø Specify the SendClockFactor in the field SendClockFactor either in
decimal format in the left input field (Range of values 0…65535) or in
hexadecimal format in the right input field (Range of values 0…0xFFFF).

Ø Specify the ReductionRatioFactor in the field ReductionRatioFactor
either in decimal format in the left input field (Range of values 0…65535)
or in hexadecimal format in the right input field (Range of values 0…
0xFFFF).

1. In order to store the configured device/module/submodule you have
entered within this dialog:
Ø Click at Finish.
ð The entered configuration data for the device/module are stored within

the project.

If for any reason you do not want to store the data, you can leave the dialog
by clicking at Cancel.

There are two possibilities to configure a variable within the device
configuration. Either you can load a GSDML file describing this variable or
you perform the following steps:
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Configure variable

One or more variables are subordinated to a submodule. In order to
configure these variables, proceed as follows:
Ø Open the context menu. Rightclick at the submodule within the element

list
Ê The context menu is opened.

Figure 53: Context menu entry "Add variable"

Ø Select the entry Add variable
Ê The variable assistant is opened:

Figure 54: Variable Wizard - first page (Parameter)
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Within the Variable Wizard, the following specifications concerning the
configuration are made:

Name
Ø Specify the name of the variable here. This field is mandatory. As long

as no input hs been done, a red frame is displayed around the input
field Name and the button Finish is deactivated and grayed out. 
This nameis also displayed in the variable area within the block Variable
Info, see section „Variable area“.

Unit
Ø This field contains the unit to be applied to the variable. The field is

optional and purely informative.

Type
Ø Specify the datatype of the variable here. This field is mandatory.

Note:
List of suitable datatypes
A list of suitable datatypes can be found at Supported Data Types.

Ø The length of the data type specified under Type given as number of
bits. Specify this length either in the left input field decimally or in the
right input field hexadecimally. 
This value depends on the choice at Type. At every selection of the
type, the maximum allowed value matching the length of the data type
in bits, is used as default value. However, you can also selct lower
values. In such a case, the remaining bits are extended up to the full
datatype also taking into account the sign, if necessary. 
This field is mandatory.

Byte order
Ø Specify here, whether the order of bytes within a word shall be swapped

Swapped or not(Not swapped). This field is mandatory.

Ø This data field contains the offset of the variable to the beginning ogf the
IO Data Object in the PROFINET Frame given as number of bytes.
This field is mandatory.

Bit offset
Ø This data field contains the number of bits which the variable has been

shiftted at the beginning of the IO Data Object. A non-negative value
between 0 and 7 has to be specified here.
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Direction
Ø This selection list allows you to select the signal direction to be applied.

Applicable options are:
· Input
· Output

The signal direction is also displayed within the variable area. This field is
mandatory
Ø Click at Next.
Ê The second page of the dialog Add variable appears:

Figure 55: Dialog Variable Wizard - third page (Normalization/Downsampling)

On this page you can specify how to normalize the measured data.

The fields in dialog Variable Wizard have the following meaning:

Type

Here select the normalization type of the list. 
If the option None is chosen, the values Scale and Offset are set to 0 and
thus no normalization of the measured data takes place. Otherwise, it is
possible to perform a user-defined normalization using the fields Scale and
Offset. 
During this normalization, the initial value is first multiplied with the factor
Scale and then the Offset is added to the product.

Scale

Specify the factor Scale for the user-defined normalization here.
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Offset

Specify the offset for the user-defined normalization here:
Ø Click at Finish in order to display the configured variable in your project.
ð The entered configuration data for the variable are stored within the

project.

Downsampling area

This area contains the specifications for performing downsampling in the
Passive Fieldbus Configurator.

Selection list Downsample Type

The following options are provided by selection list Downsample Type.
Option Description
Switched off No downsampling of data occurs. All data values are acquired by

the network at their individual cycle.
Only on change In this setting, acquired data will be transferred to the subsequent

processing only if changes occur.
Downsampling If downsampling has been activated, the data are regularly sampled

after a defined time interval (the downsampling rate) and only those
sampled values are transferred to subsequent processing. This
time interval is specified in input field Downsample Rate.

Input field Downsample-Rate

If the Downsample Type Downsampling has been selected, in this input
field the downsample rate can be specified in units of milliseconds. The
allowed range of values extends from 1 to 1000 Milliseconds. See the
following figure.

Figure 56: Edit custom value filter – Downsampling-Type and -Rate
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4.2.6 Step 6 - Signal configuration
In order to activate a signal, proceed as follows:
Ø Within the Passive Fieldbus Configurator, drag the signal from the

element list window into the window „Signal configuration“.
Ê In window "Signal configuration", a new entry with the name of the

signal is displayed There you can also decide whether the processing of
this signal shall be continued by transferring it to OPC UA or Node-
RED.

Note:
In order to reduce CPU time and memory consumption on the Edge
Gateway only choose those methods for continuation of processing,
which you really need in your specific application.

Ê The entry with the name of the signals within the element list still
remains there, but it is now protected against editing and erasure, i.e.
the respective context menu functions are grayed out and deactivated.

Figure 57: Window "Signal configuration" of the Passive Fieldbus Configurator.

Ø Configure the signals in the window Signal configuration of the
Passive Fieldbus Configurator. By checking the checkbox, you can
separately determine for each single PROFINET IO signal, whether the
acquired data shall be fetched from the Edge Gateway by OPC-UA or
transferred into the cloud by Node-RED. whether
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4.2.7 Step 7 - Check Signals in the Live-Data View
This step is optional. Viewing signals within a live-data window is
recommended if you want to check whether a specific signal has been
configured correctly

Proceed as follows to start recording the PROFINET network traffic:
Ø Within the side menu of Passive Fieldbus Configurator (right side), click

at button Start.
Ø Drag all signals intended to be viewed in the window Live Data one by

one with the mouse button pressed down from the element list into the
right part Buckets of the Live Data window.

Ê The data acquisition within the Passive Fieldbus Configurator has been
started. In the Live View window you can watch the signals and tune
your configuration if necessary.

4.2.8 Step 8 - Storing the generated configuration file (PROFINET)
Ø Create a configuration file (i.e. a project file) for your PROFINET project

using the Passive Fieldbus Configurator. Store this file via Project >
Save within the main menu before finishing working with the Passive
Fieldbus Configurator .

ð You have now created a project file for the configuration of your
PROFINET network within the passive mode of the Edge Gateway. In
section Uploading the project file to the Edge Gateway [} page 113]
uploading of this file onto the Edge Gateway and activating it is
described.
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4.3 EtherCAT (automatic)
This section describes step-by-step the commissioning of the passive
process data acquisition of the Edge Gateway in an EtherCAT network
using an ENI file.

In the following description eight steps explain how you can create a project
file for passive process data acquisition with the Edge Gateway in your
EtherCAT network (Steps1 to 7) without any manual slave configuration
and upload this project file into the Edge Gateway then (Step 8, see
separate description Uploading the project file to the Edge
Gateway [} page 113]).

Contrary to the PROFINET configuration, the EtherCAT configuration can
be done offline, i.e. without connection to the Edge Gateway.

The following figure shows the wiring diagram related to this step-by-step
instruction. The Edge Gateway is wired as passive access point between
EtherCAT Master and the first EtherCAT Slave in order to capture the
network communication between those completely.

Figure 58: Wiring diagram for passive process data acquisition with the Edge Gateway
NIOT-E-TIJCX-GB-RE in EtherCAT networks
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The following prerequisites must be fulfilled for the EtherCAT configuration.
1. The software Passive Fieldbus Configurator must be installed on a PC,

from which network access to the Edge Gateway can be accomplished.
If this is not the case, install it according to the installation instructions.

2. The IP address of the Edge Gateway to be used must be known.
3. A suitable ENI-File for your EtherCAT project must be present.

Note:
ENI files from TwinCAT are supported. ENI files from other
Engineering Tools can only be read if these contain detailed
descriptions of the RxPDOs and TxPDOs. At Codesys the ENI file
uses other bus addresses as they have been parameterized on the
network. For affected versions of Codesys, the bus addresses must
be manually adapted within the Passive FB Configurator after
importing the ENI files. See .

If there is no suitable ENI file present, a manual configuration can be made,
see EtherCAT (manual) [} page 69].

4.3.1 Step 1 - Program start
Ø Start the Passive Fieldbus Configurator on your PC, for example via the

entry netIOT – Passive Fieldbus Configurator in the Windows start
menu or by double-clicking at the icon netIOT - Passive Fieldbus
Configurator.

ð The entry screen of the Passive Fieldbus Configurator is displayed:

4.3.2 Step 2 - Creating an empty project
Ø Build a new project within the Passive Fieldbus Configurator by

selecting 
Create->New within the introductory menu..

Ê The (still empty) GUI of the Passive Fieldbus Configurator is displayed.
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4.3.3 Step 3 - Adjust basic settings of the Passive Fieldbus Configurator.
The Passive Fieldbus Configurator requires the following basic settings:
· Setting of IP address
· Setting ofSetting of network speed

To do so, proceed as follows:
Ø Open the main menu. in order to do so, click at button Menu within the

side menu located at the right side.

Figure 59: Side menu

Ê The main menu is opened.

Figure 60: main menu - Register card "Views"
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Ø Select the register card Device assignment.

Figure 61: main menu - Register card "Device assignment"

In order to establish a connection with the Edge-Gateway, the IP address of
the Edge-Gateway must be assigned to the software. This reqires the
Gateway being in the passive mode of operation. Proceed as follows:
Ø Select the IP addresss of the Edge-Gateway to connect with from the

selection list IP Address in the device selection area. If this list is still
empty yet or the IP address of the Edge Gateway is missing in it,
specify the IP address within the input field or click at the cog wheel

symbol  at the right and specify the IP address in the dialog box
which will appear. This IP address must comply with the valid rules for
specifying IP adresses.

Ø Click at .
Ê Finally, the connection with the according Edge Gateway has been

established.

As described in the following, you can check whether a connection to the
Edge Gateway has been established:
1. In the field Firmware Version the version number of the currently

installed firmware of the Edge Gateway is displayed.
2. The status display in the right part of the lower status bar of the Passive

Fieldbus Configurator changes from blue indicating status Idle to yellow
indicating status Stopped.

3. In the left part of the status bar now statistic information concerning the
Ethernet data traffic and zthe interface configuration are displayed.

4. The formerly grayed ot menu entry Connect is activated.
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Otherwise the following error message will appear:

Figure 62: Error message "The connection to the device was not possible"

The most probable cause of this error message is the Edge Gateway not
being in the configuration mode of the passive mode of operation!

Note:
For more information concerning the solution of this problem see
section Error handling [} page 116].

Ø In order to adjust the network speed, select the network speed from the
selection list Network speed in the area TAP configuration

Figure 63: Selection list Network speed

For the network speed, the following settings are applicable:
Setting Meaning
Auto Automatic determination of network speed

Select this option if using the Edge Gateway as Software TAP.
Possible value
are Auto, 10
MBit/s and 100
MBit/s.

Fixed network speed of 100 Mbit/s
Select this option if working with an additional Hardware TAP.

Table 9: Settings for network speed
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4.3.4 Step 4 - Upload the ENI file
How to load an ENI file with the device description of your EtherCAT-
Master and the connected EtherCAT-Slaves into the Passive Fieldbus
Configurator (ENI = EtherCAT Network Information):
Ø Right-click at Network (Tap A).
Ê The context menu is opened.

Figure 64: Context menu at network level

Ø There select the topmost entry Edit network.
Ê The first page of the Network Wizard for EtherCAT is opened.

Figure 65: First page of the Network Wizard for EtherCAT

Ø Within the network wizard, select EtherCAT as network protocol.

Figure 66: Selection of network protocol
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Ø Click at Next.
Ê The second page of the Network Wizard for EtherCAT is opened.

Figure 67: Second page of the Network Wizard for EtherCAT

Ø In the selection Direction the data direction of the EtherCAT network
can be configured.

Option Meaning
Automatic The recognition of the data direction is done

automatically. Select this option by default. 
If you apply a Hardware-TAP, automatic recognition of
the data direction is necessarily required.

Port 0|2 input, Port 1|3
output

The side of the network close to the PLC is connected
to the upper RJ45 connector of the field bus interface
(Port 0). By the selection of a fixed direction the
decoding performance on the Edge Gateway is
increased. Select this option if not using an additional
Hardware TAP.

Port 0|2 output, Port 1|3
input

The side of the network close to the PLC is connected
to the lower RJ45 connector of the field bus interface
(Port 1). By the selection of a fixed direction the
decoding performance on the Edge Gateway is
increased. Select this option if not using an additional
Hardware TAP.

Table 10: Options for the data direction within an EtherCAT network
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Ø Click at Finish.

Figure 68: EtherCAT Import

Ø Click at Import (right beside Device descriptions).
Ê A dialog for selcting the ENI file is displayed.
Ø Select the ENI file for your EtherCAT device there.
ð The device descriptions contained within the ENI file are imported and

integrated into the structure tree within the element list of the Passive
Fieldbus Configurator.
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4.3.5 Step 5 - Signal configuration
In order to activate a signal, proceed as follows:
Ø Within the Passive Fieldbus Configurator, drag the signal from the

element list window into the window „Signal configuration“. 
To do so, check the signal(s) in window Element List and keep the
mouse button pressed while moving the mouse cursor to the window
"Signal configuration". The figure below shows the state before
releasing the mouse button. The red line is used only for clarification.

Figure 69: Signal configuration - during Drag&Drop

Ê If the mouse button is released, a new entry with the name of the signal
is displayed in window „Signal configuration“.

The entry with the name of the signals within the element list still remains
there, but it is now protected against editing and erasure, i.e. the respective
context menu functions are grayed out and deactivated.
Ø Configure the signals in the window Signal configuration of the

Passive Fieldbus Configurator. In window "Signal configuration", a new
entry with the name of the signal is displayed. For each single
EtherCAT signal, you can also decide there, whether the acquired data
shall be fetched from the Edge Gateway by OPC-UA or transferred into
the cloud by Node-RED.

Note:
In order to reduce CPU time and memory consumption on the Edge
Gateway only choose those methods for continuation of data
processing, which you really need in your specific application.
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4.3.6 Step 6 - Check Signals in the Live-Data View
This step is optional. However, it allows a quick and easy check whether a
signal has been configured correctly.

The Live Data window consists of a display area on the left side, which can
be separated into some stacked parts (Buckets), and of an area on the right
side only containing a register card buckets that lists the current signals
and their assignment to these areas (Buckets)

Figure 70: Adding signals to the Live Data window

To view and record arbitrary signals of your choice within the live data
window, start recording as follows:
Ø Drag all signals intended to be viewed in the window Live Data one by

one with the mouse button pressed down from the element list into the
right part Buckets of the Live Data window.

Ê The data acquisition within the Passive Fieldbus Configurator has been
started. In the Live View window you can watch the signals and tune
your configuration if necessary.
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4.3.7 Step 7 - Storing the generated configuration file (EtherCAT)
Ø Create a configuration file (i.e. project file) for your EtherCAT project

using the Passive Fieldbus Configurator. Store this file via Project >
Savewithin the main menu before finishing working with the Passive
Fieldbus Configurator .

ð You have now created a project file in the *.fbcfg format for the
configuration of your EtherCAT network within the passive mode of the
Edge Gateway. In section Uploading the project file to the Edge
Gateway [} page 113] uploading of this file onto the Edge Gateway and
activating it there is described.
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4.4 EtherCAT (manual)
this section describes themethod for manually commissioning the passive
process data acquisition with the Edge Gateway in EtherCAT networks.

This method is especially suited if no ENI file for your EtherCAT network is
present. This means, all devices of the EtherCAT network have to be
configured manually.

The following figure shows the wiring diagram related to this step-by-step
instruction. The Edge Gateway is wired as passive access point between
EtherCAT Master and the first EtherCAT Slave in order to capture the
network communication between those completely.

Figure 71: Wiring diagram for passive process data acquisition with the Edge Gateway
NIOT-E-TIJCX-GB-RE in EtherCAT networks
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In the following description nine steps explain how you can create a project
file for passive process data acquisition with the Edge Gateway in your
EtherCAT- network (Steps1 to 8) and upload this project file into the Edge
Gateway then (Step9, see separate description Uploading the project file to
the Edge Gateway [} page 113]).

For this, the following prerequisites must be fulfilled:
1. The Passive Fieldbus Configurator has to be installed on a PC that

allows you to access to Edge Gateway via the netwok. If this software is
not installed yet, then install it according to the installation instruction
first.

2. You have to know the IP address of the Edge Gateway.

4.4.1 Step 1 - Start the Passive Fieldbus Configurator.
Ø Start the Passive Fieldbus Configurator on your PC, for example via the

entry netIOT – Passive Fieldbus Configurator in the Windows start
menu or by double-clicking at the icon netIOT - Passive Fieldbus
Configurator.

ð The entry screen of the Passive Fieldbus Configurator is displayed:

4.4.2 Step 2 - Creating an empty project
Ø Build a new project within the Passive Fieldbus Configurator by

selecting the right button
Create->New within the introductory menu..

Ê The (still empty) GUI of the Passive Fieldbus Configurator is displayed.
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4.4.3 Step 3 - Adjust basic settings of the Passive Fieldbus Configurator.
The Passive Fieldbus Configurator requires the following basic settings:
· Setting of network speed

To do so, proceed as follows:
Ø Open the main menu. in order to do so, click at button Menu within the

side menu located at the right side.

Figure 72: Side menu

Ê The main menu is opened.

Figure 73: main menu - Register card "Views"

Ø Select the register card Device assignment.

Figure 74: main menu - Register card "Device assignment"
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The main menu of the Passive Fieldbus Configurator consists of two areas:
· the area Device selection (top)
· the area TAP Configuration (down)

The network speed is selected in the area TAP configuration.
Ø In order to adjust the network speed, select the network speed from the

selection list Network speed in the area TAP configuration

Figure 75: Selection list Network speed

For the network speed, the following settings are applicable:
Setting Meaning
Auto Automatic determination of network speed

Select this option if using the Edge Gateway as Software TAP.
Possible value
are Auto, 10
MBit/s and 100
MBit/s.

Fixed network speed of 100 Mbit/s
Select this option if working with an additional Hardware TAP.

Table 11: Settings for network speed
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4.4.4 Step 4 - Configuration of the Process Fieldbus Configurators for
EtherCAT

So you configure the Process Fieldbus Configurators for EtherCAT
Ø Right-click at Network (Tap A).
Ê The context menu is opened.

Figure 76: Context menu at network level

Ø There select the topmost entry Edit network.
Ê The first page of the Network Wizard for EtherCAT is opened.

Figure 77: First page of the Network Wizard for EtherCAT

Ø Within the network wizard, select EtherCAT as network protocol.

Figure 78: Selection of network protocol
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Ø Click at Next.
Ê The second page of the Network Wizard for EtherCAT is opened.

Figure 79: Second page of the Network Wizard for EtherCAT

Ø In the selection Direction the data direction of the EtherCAT network
can be configured.

Option Meaning
Automatic The recognition of the data direction is done

automatically. Select this option by default. 
If you apply a Hardware-TAP, automatic recognition of
the data direction is necessarily required.

Port 0|2 input, Port 1|3
output

The side of the network close to the PLC is connected
to the upper RJ45 connector of the field bus interface
(Port 0). By the selection of a fixed direction the
decoding performance on the Edge Gateway is
increased. Select this option if not using an additional
Hardware TAP.

Port 0|2 output, Port 1|3
input

The side of the network close to the PLC is connected
to the lower RJ45 connector of the field bus interface
(Port 1). By the selection of a fixed direction the
decoding performance on the Edge Gateway is
increased. Select this option if not using an additional
Hardware TAP.

Table 12: Options for the data direction within an EtherCAT network

Ø Click at Finish.
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4.4.5 Step 5 – Manual configuration of the EtherCAT network
If there is no ENI file present for the EWtherCAT network, all devices of the
EtherCAT network must be configured manually. To do so, you have to
model the network structure manually within the structure tree of the
Passive Fieldbus Configurator, by performing both of the steps of work
described in the following (if necessary, repeatedly), until all slave devices
and variables are present.
1. Add a slave device to the network
2. Add variables to a master or slave device

Add a slave device

When manually defining a new slave, the configuration data must be
entered via the dialog Add slave(Context menu entry Add slave). Bei der
manuellen Definition eines neuen Slaves müssen die Konfigurationsdaten
über den Dialog Slave einfügen eingegeben werden (Kontextmenü-Eintrag
Gerät hinzufügen). Um ein Slave-Gerät im Strukturbaum innerhalb der
Element-Liste des Passive Fieldbus Configurators hinzuzufügen und
dessen Konfigurationsdaten manuell einzugeben, gehen Sie wie folgt vor:
Ø Within the element list, rightclick at the Master under which the variable

shall be added.
Ê Open the context menu of the master.

Figure 80: Context menu for EtherCAT Master
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Ø Within the context menu, click at the entry Add device
Ê The first page of the dialog Add slave is opened.

Figure 81: Dialog „Add slave - first page (Name)"

Ø Under Name specify the name which shall identify the EtherCAT Slave
device in future.

Ø Click at Next.
Ê The second page of the dialog Add slave is opened.

Figure 82: Dialog Add slave - second page"(Parameter)
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Within the dialog Add slave, the following specifications concerning the
configuration are made:

Configured station address

This address is used at the node addressing method. The value is entered
decimally in the left input field or hexadecimally in the right input field. The
allowed range of values for the configured station address extends from 0
to 0xFFFF.

Note:
For more information on the node addressing method, see the
EtherCAT specification, Part 3, Section 4.8.3.3 "Node Addressing".

Autoincrement address

This address is used at the position addressing method. The value is
entered decimally in the left input field or hexadecimally in the right input
field. The allowed range of values for the configured station address
extends from 0 to 0xFFFF.

Note:
For more information on the node addressing method, see the
EtherCAT specification, Part 3, Section 4.8.3.2 "Position
Addressing".

Physics

This parameter specifies the port type of the connection on the physical
layer (i.e. on layer 1 of the OSI/ISO layer model of networking).

Up to four capital letters taken from the set {B, F, K, Y} characterizes
the port typeof port 0 up to port 3 in this order.

The meaning of these letters is defined as follows:
Letter Corresponding port type
Y Ethernet Copper (100BaseTX)
F Ethernet Fiber-optic (100BaseFX)
K E-Bus Backplane
B Reserved
Space Not used

Table 13: Coding of parameter "Physics"
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Vendor ID

This parameter represents the Vendor ID within the Identity Object of the
EtherCAT Object Dictionary (Index 0x1018, Subindex 1).

The value is entered decimally in the left input field or hexadecimally in the
right input field. The allowed range of values for Vendor ID extends from 0
to 0x7FFFFFFF (0 up to 2.147.483.647).

Product code

This parameter represents the product code in the Identity Object within the
EtherCAT Object Dictionary (Index 0x1018, Subindex 2).

The value is entered decimally in the left input field or hexadecimally in the
right input field. The allowed range of values for the Product Code extends
from 0 up to 0xFFFFFFFF (corresponding to 0 up to 4294967295).

Revision number

This parameter represents the Revision number in the Identity Object within
the EtherCAT Object Dictionary (Index 0x1018, Subindex 3).

The value is entered decimally in the left input field or hexadecimally in the
right input field. The allowed range of values for the Product Code extends
from 0 up to 0xFFFFFFFF (corresponding to 0 up to 4294967295).

Note:
For more information concerning VendorID, Product Code and
Revision Number, see EtherCAT Specification Part 6 Section
5.6.7.4.6 Identity Object.
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In order to insert a variable, proceed as follows:

Add a variable

A variable can either be inserted below the Master or an arbitrary EtherCAT
Slave device.

Below the EtherCAT Master, the context menu looks like this:

Figure 83: Context menu for EtherCAT Master

Below any EtherCAT Slave device, the context menu looks like this:

Figure 84: Context menu for EtherCAT Slave

In both cases you can use the context menu entry Add variable as follows
in order to add a variable to the element list.
Ø Within the element list, rightclick at the master or slave under which the

variable shall be added.
Ê The context menu appears, see above.
Ø Click at the context menu entry Add variable
ð The frst page of the dialog Variable Wizard is opened.It looks as

follows:

Figure 85: Variable Wizard - first page

Ø Under Name specify the name which shall identify the variable in future.
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The fields within the dialog Add variable have the following meaning:

Name

The name of the variable

The name identifying the variable to be defined here. As long as no input
into this mandatory field occurs, the input field has a red frame.

This name is also displayed in the variable area of the variable to be
defined within the block Variable Info, see section „Variable area“.

Type

The datatype of the variable You can find a list of suitable datatypes in List
of supported Data Types for Variables.

Unit

The coreresponding unit of the variable

The length of the data type specified under Type given as number of bits.

Here, the bit length can be set to values from 1 up to the maximum bit width
of the selected datatype. If less bits are chosen than the used data types
has, for unsigned datatypes the remaining bits are filled with 0..For signed
datatypes the sign is extended onto the remaining bits.

Byte order

Here it can be spefcified whether the order of bytes in a data word is
swapped (Swapped) or not (Not swapped).
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Direction

This selection list allows you to select the signal direction to be applied.

Here, "input" means data transfer from the EtherCAT Slaves to the
EtherCAT Master, while "output" means data transfer from the EtherCAT
Master to the EtherCAT Slaves,

See also section Definition of Signal Directions.

However, the available choices depend on the kind of command selected at
selection list Command which has been described just above:
Kind of command Affected EtherCAT command

codes
Selection options

Read commands APRD, FPRD, BRD and LRD Input only
Write commands APWR, FPWR, BWR and LWR Output only
Read/ write
commands

APRW, ARMW, FPRW, FRMW,
BRW and LRW

Input and Output are selectable

Table 14: Possible selections depending on mode of operation

Ø Click at Next.
Ê The second page of the dialog Variable Wizard is opend.

Figure 86: Dialog Variable Wizard - second page

On the second page of the dialog it is possible to store a sorted series of
EtherCAT commands.

These EtherCAT commands can be accessed by the selection list below
Selected command. Anyway, specified changes only affect the command
currently selected in the selection list Selected command. This happens
as follows:
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Adding a command

For each variable exactly one EtherCAT command is stored by default. In
order to add further EtherCAT commands perform the following series of
steps once per EtherCAT command to be added.
Ø Click at the plus-symbol righjt of theselection list below Selected

command.
Ê A new EtherCAT command is added at the end within the series of

commands.
Ø Specify the name of the command at Command name.
Ø Select the EtherCAT command to be executed from a list of commands

supported by EtherCAT using the selection list Command.
Ø Fill the other fields for this commands as shown below.
ð Now the command has been entered.

Editing a command

A prevciously entered command can be changed as follows:
Ø Perform the desired change in the respective field. For instance, in

order to edit the name of the command, just specify the new command
name in the field Command name.

ð The command is changed.

Deleting a command

You can delete an already entered command as follows:
Ø Click at the trashcan symbol right of the selection list below Selected

command
ð The command including all stored related information is deleted.

The other fields witin the dialog Variable Wizard have the following
meaning:

Freely selectable command name (editable, is displayed in selection list
Selected command along with the command code

Bit offset in command

This data field contains the offset of the variable relative to the beginning of
the Data field in the EtherCAT datagram. It is counted as number of bits
from the position of the first bit of the first variable in the data field of the
EtherCAT datagram.If the variable to be defined is the first one within the
data field of the EtherCAT datagram, then this value equals 0.

If an invalid value is entered, this is emphasized by a red frame around the
field Bit offset. However, it does not make sense to specify values
exceeding 11888 (equivalent to 8*1486).
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Command

If a single variable value should be transferred via EtherCAT by multiple
commands, more commands can be added in the command list as
necessary.

For an overview on the applicable EtherCAT command codes, see section
List of Commands or the EtherCAT specification (reference [2]).

This data field contains the length of the EtherCAT datagram specified as
number of bytes of the datagram.

This corresponds to the EtherCAT command specified in field "Data
Length" in the EtherCAT datagram, see EtherCAT Datagram Structure.

The allowed range of values extends from 0 to 1486. If an invalid value is
entered, this is emphasized by a red frame around the field Data length of
the command..However, it does not make much sense to specify larger
values than 1486 here.This value corresponds to the length of the data
area within the EtherCAT datagramm.

Working counter

This field contains the expected value of the working counter (WKC).

The WKC value is used for the determination of the validity status of a
variable value. For a WKC value unequal to the value specified here, the
status is automatically set to invalid.

This corresponds to the EtherCAT command specified in the field Expected
Working Counter within the EtherCAT datagram. See EtherCAT Datagram
Structure.

The WKC value is automatically adjusted if another Edge Gateway
installation location is chosen.

The allowed range of values extends from 0 to 4294967295.
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Command address

Depending on the choice in the selection list Command different kinds of
addresses can be specified here.
· If a command with autoincrement addressing such as APRD, APWR or

APRW has been chosen there, the autoincrement address and an offset
can be specified here. The input field is denominated as autoincrement
address. The values of the autoincrement address and the offset are
both specified as hexadecimal value. The allowed range of values
extends from 0 to 0xFFFF.

· If a command with addressing via the configured station address such
as CPRD, CPWR or CPRW has been chosen there, the configured
station address and an offset can be specified here. The input field is
designated as configured station address. The values of the configured
station address and the offset are both specified as hexadecimal value.
The allowed range of values extends from 0 to 0xFFFF.

· If a command with broadcast addressing such as BRD, BWR or BRW
has been chosen there, the broadcast address and an offset can be
specified here. The input field is designated as broadcast address. The
values of the broadcast address and the offset are both specified as
hexadecimal value. The allowed range of values extends from 0 to
0xFFFF.

· If a command with logical addressing such as LRD, LWR or LRW has
been chosen there, the logical address can be specified here. The input
field is designated as logical address. The values of the logical address
is specified as hexadecimal value. The allowed range of values extends
from 0 to 0xFFFFFFFF.

This field corresponds to the EtherCAT command specified in the field
"Command address" within the EtherCAT datagram. See EtherCAT
Datagram Structure.
Ø Click at Next..
Ê The third page of the Variable Wizard dialog is opened.

Figure 87: Dialog Variable Wizard - third page (Normalization/Downsampling)
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On this page you can specify how to normalize the measured data.

The fields in dialog Variable Wizard have the following meaning:

Type

Here select the normalization type of the list. 
If the option None is chosen, the values Scale and Offset are set to 0 and
thus no normalization of the measured data takes place. Otherwise, it is
possible to perform a user-defined normalization using the fields Scale and
Offset. 
During this normalization, the initial value is first multiplied with the factor
Scale and then the Offset is added to the product.

Scale

Specify the factor Scale for the user-defined normalization here.

Offset

Specify the offset for the user-defined normalization here:
Ø Click at Finish in order to display the configured variable in your project.
ð The entered configuration data for the variable are stored within the

project.

Downsampling area

This area contains the specifications for performing downsampling in the
Passive Fieldbus Configurator.

Selection list Downsample Type

The following options are provided by selection list Downsample Type.
Option Description
Switched off No downsampling of data occurs. All data values are acquired by

the network at their individual cycle.
Only on change In this setting, acquired data will be transferred to the subsequent

processing only if changes occur.
Downsampling If downsampling has been activated, the data are regularly sampled

after a defined time interval (the downsampling rate) and only those
sampled values are transferred to subsequent processing. This
time interval is specified in input field Downsample Rate.
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Input field Downsample-Rate

If the Downsample Type Downsampling has been selected, in this input
field the downsample rate can be specified in units of milliseconds. The
allowed range of values extends from 1 to 1000 Milliseconds. See the
following figure.

Figure 88: Edit custom value filter – Downsampling-Type and -Rate
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4.4.6 Step 6 - Signal configuration
In order to activate a signal, proceed as follows:
Ø Within the Passive Fieldbus Configurator, drag the signal from the

element list window into the window „Signal configuration“. 
To do so, check the signal(s) in window Element List and keep the
mouse button pressed while moving the mouse cursor to the window
"Signal configuration". The figure below shows the state before
releasing the mouse button. The red line is used only for clarification.

Figure 89: Signal configuration - during Drag&Drop

Ê If the mouse button is released, a new entry with the name of the signal
is displayed in window „Signal configuration“.

The entry with the name of the signals within the element list still remains
there, but it is now protected against editing and erasure, i.e. the respective
context menu functions are grayed out and deactivated.
Ø Configure the signals in the window Signal configuration of the

Passive Fieldbus Configurator. In window "Signal configuration", a new
entry with the name of the signal is displayed. For each single
EtherCAT signal, you can also decide there, whether the acquired data
shall be fetched from the Edge Gateway by OPC-UA or transferred into
the cloud by Node-RED.

Note:
In order to reduce CPU time and memory consumption on the Edge
Gateway only choose those methods for continuation of data
processing, which you really need in your specific application.
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4.4.7 Step 7 - Check Signals in the Live-Data View
This step is optional. However, it allows a quick and easy check whether a
signal has been configured correctly.

The Live Data window consists of a display area on the left side, which can
be separated into some stacked parts (Buckets), and of an area on the right
side only containing a register card buckets that lists the current signals
and their assignment to these areas (Buckets)

Figure 90: Adding signals to the Live Data window

To view and record arbitrary signals of your choice within the live data
window, start recording as follows:
Ø Drag all signals intended to be viewed in the window Live Data one by

one with the mouse button pressed down from the element list into the
right part Buckets of the Live Data window.

Ê The data acquisition within the Passive Fieldbus Configurator has been
started. In the Live View window you can watch the signals and tune
your configuration if necessary.
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4.4.8 Step 8 - Storing the generated configuration file (EtherCAT)
Ø Create a configuration file (i.e. project file) for your EtherCAT project

using the Passive Fieldbus Configurator. Store this file via Project >
Savewithin the main menu before finishing working with the Passive
Fieldbus Configurator .

ð You have now created a project file in the *.fbcfg format for the
configuration of your EtherCAT network within the passive mode of the
Edge Gateway. In section Uploading the project file to the Edge
Gateway [} page 113] uploading of this file onto the Edge Gateway and
activating it there is described.
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4.5 Custom value filters
In Passive Fieldbus Configurator you can work with custom-value filters
(i.e. user- defined filters). This gives you the chance to detect and select
nearly arbitrary kinds of Ethernet frames.

A single criterion for frame selection can be specified using selection list
Type.

This opens many possibilities to define new criteria that are presented
within the following table:
Frame selection method Typical examples
According to Ethernet
characteristics

Only select frames with a certain Ethertype or VLAN-Tag 
Only select frames with a certain Source or Destination MAC

According to IP
characteristics

Only select IP-Frames, IPv6-Frames, TCP-Frames, UDP-
Frames 
Only select IP-Frames with a certain Source or Destination-IP-
Address 
Only select TCP-Frames with a certain Source or Destination-
Port

According to protocol-
specific frame types

Only select EtherCAT-Frames 
Only selectPROFINET-Frames 
Only select frames with a certain Frame-ID 
Only select ICMP, LLDP, ARP, MRP or SNMP frames

Table 15: Criteria for frame selection

After the filter has been defined, it must finally be taken over into the signal
configuration and thereby be activated.

This shall be illustrated in the following using an example:

Example - Definition of own filter conditions

As an example how to apply the Edge Gateway in the passive mode for the
detailed analysis of Ethernet frame data, we show you how to extract all
poll requests out of the data traffic within a Powerlink network which are
sent from a Powerlink Controlled Node with address 1 as broadcast (i.e. to
all participants).

This is accomplished by defining a filter for the Edge Gateway within the
Passive Fieldbus Configurator which is able to select all Powerlink frames
with a certain Message Type (here Poll Request) and a certain source
address (Controlled Node) and destination address (Broadcast).

This section describes how you can use custom-value filters to create a
project file enabling the Edge Gateway for passive data acquisition within a
Powerlink network In this way you can learn valuable and important
concepts how you can solve a manifold of similar problems using
thepassive data acquisition.

If the project file has been generated, it finally has to be uploaded to the
Edge Gateway as described in Uploading the project file to the Edge
Gateway [} page 113].
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The following prerequisites have to be met:
1. The Passive Fieldbus Configurator must be installed. If this is not the

case, install it according to the installation instructions.
2. The IP address of the Edge Gateway to be used must be known.

4.5.1 Step 1 - Start the Passive Fieldbus Configurator.
Ø Start the Passive Fieldbus Configurator on your PC,

4.5.2 Step 2 - Creating an empty project
Ø Build a new project within the Passive Fieldbus Configurator by

selecting the right button
Create->New in the introductory menu..

Ê The (still empty) GUI of the Passive Fieldbus Configurator is displayed.
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4.5.3 Step 3 - Adjust basic settings of the Passive Fieldbus Configurator.
The Passive Fieldbus Configurator requires the following basic settings:
· Setting of IP address
· Setting ofSetting of network speed

To do so, proceed as follows:
Ø Open the main menu. in order to do so, click at button Menu within the

side menu located at the right side.

Figure 91: Side menu

Ê The main menu is opened.

Figure 92: main menu - Register card "Views"
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Ø Select the register card Device assignment.

Figure 93: main menu - Register card "Device assignment"

In order to establish a connection with the Edge-Gateway, the IP address of
the Edge-Gateway must be assigned to the software. This reqires the
Gateway being in the passive mode of operation. Proceed as follows:
Ø Select the IP addresss of the Edge-Gateway to connect with from the

selection list IP Address in the device selection area. If this list is still
empty yet or the IP address of the Edge Gateway is missing in it,
specify the IP address within the input field or click at the cog wheel

symbol  at the right and specify the IP address in the dialog box
which will appear. This IP address must comply with the valid rules for
specifying IP adresses.

Ø Click at .
Ê Finally, the connection with the according Edge Gateway has been

established.

As described in the following, you can check whether a connection to the
Edge Gateway has been established:
1. In the field Firmware Version the version number of the currently

installed firmware of the Edge Gateway is displayed.
2. The status display in the right part of the lower status bar of the Passive

Fieldbus Configurator changes from blue indicating status Idle to yellow
indicating status Stopped.

3. In the left part of the status bar now statistic information concerning the
Ethernet data traffic and zthe interface configuration are displayed.

4. The formerly grayed ot menu entry Connect is activated.
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Otherwise the following error message will appear:

Figure 94: Error message "The connection to the device was not possible"

The most probable cause of this error message is the Edge Gateway not
being in the configuration mode of the passive mode of operation!

Note:
For more information concerning the solution of this problem see
section Error handling [} page 116].

4.5.4 Step 4 - Define filter conditions for custom-value filters
The editor allows logic operations connecting multiple criteria.

The following kinds of logic operations are available.
· Void (no logic operation, only a single filter value is used)

· and(AND operation)

· Or(OR conjunction)

· not(Negation, only a single filter value is used)

· xorExclusive-OR-conjunction)
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To define the filter required for the example totally four filter criteria which
are related to one another are used.
· The first filter criterion is used to detect whether the current frame is a

Powerlink frame. In order to detect Powerlink frames their Ethertype can
be used. In general, Powerlink frames have the Ethertype 0x88AB. So
the Ethertype of the frame to be tested must be checked for equality
with the hexadecimal value 0x88AB.

· The second filter criterion is used to check whether a poll request is
present.A check whether the Message Type located in thew byte with
offset 14 within the Ethernet frame equals 4 is required

· The third filter criterion is used for detection of broadcasts. In order to
do so, it must be checked whether the Destination-IP address located at
the byte with offset 15 within the Ethernet frame equals 255.

· The fourth filter criterion is used to check whether the frame originates
from the Controlled Node (Slave) with the address 1 stammt. To do so,
the Source-IP address located at the byte with offset 16 within the
Ethernet Frame must be checked whether it equals 1.

Figure 95: Assignment of the four filter criteria to the Wireshark Trace
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This is accomplished by defining a filter for the Edge Gateway within the
Passive Fieldbus Configurator which is able to select all Powerlink frames
with a certain Message Type (here Poll Request) and a certain source
address (Controlled Node) and destination address (Broadcast).
Ø Open the dialog Add custom value filter using the context menu.
Ø At Filtername specify the Filtername, here Detect Powerlink frames.
Ê Now the dialog looks as follows.

Figure 96: Specify filter name

Ø Click at Next..
Ø In order to combine to criteria with a AND operation, open the selection

list and select the option And for the relation as shown in the figure.

Figure 97: Custom-value filters - Selection of logical function
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For an And-operation, you need (at least) two filter criteria.
Ø For specifying the first filter criterion Ethertype equals 0x88AB click at

the symbol .
Ê A box for specifying the filter criterion appears.

Figure 98: Custom value filters

Ø Then select the entry Ethertype directly below Ethernet within the
selection list Type, see figure:

Figure 99: Custom value filters - Selection of Ethertype for recognition of Powerlink
frames
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Ø At operator select equals in order to check for existence of Powerlink
frames.

Figure 100: Custom value filters

Ø Specify the hexadecimal value 0x88AB within the right of both fields
below Value.

ð The first filter condition Ethertype equals 0x88AB has now been
specified completely and is displayed within a box.

Figure 101: Custom value filters - first filter condition complete (including Wireshark trace)

Ø Here, you may write an optional comment into the input field Comment,
for instance Detection of Powerlink frames.
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Now the second filter criterion must be specified.
Ø In order to specify the second filter criterion Byte at Offset 14 of the

Ethernet Frames equals 4, again click at the Symbol .
Ê A second box for specifying a filter criterion appears.

Figure 102: Specifying the second filter criterion - Entering the filter condition

Ø Below type select User-definedt uint8.

Figure 103: Specifying the second filter criterion - Selection of User-defined uint8

Ê After the selection, the dialog looks as follows:
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Figure 104: Specifying the second filter criterion -Afdter selection of User-defined uint8

Ø At operator the option equals must be selected - this is also the default
option.

Ø For Value there are two input fields. the left of these is dedicated for
decimal inputs, the right one for hexadecimal inputs. Specify the value 4
within the left (decimal) input field.

Figure 105: Specifying the second filter criterion - Input of the value of Ethernet frame,
byte offset 14

Ê As soon as a valid value has been entered, the red frames around the
mandatory input fields Value are displayed in grey.

Ø Specify the offset of the byte within the Ethernet-Frameto be used for
comparison, here the byte with offset 14.
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Figure 106: Specifying the second filter criterion - Input of the offset

Ø You may write an additional comment into the input field Comment, for
instance Destination broadcast.

ð Now the dialog looks as follows.

Figure 107: Specifying the second filter criterion -
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Now the third filter criterion must be specified.
Ø In order to specify the third filter criterion Byte at Offset 15 of the

Ethernet Frames equals 255, again click at the Symbol .
Ê Another box for specifying the filter criterion appears.

Figure 108: Specifying the third filter criterion - Entering the third filter condition

Ø Below type select User-definedt uint8.

Figure 109: Specifying the second filter criterion - Selection of User-defined uint8
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Ê After the selection, the dialog looks as follows:

Figure 110: Specifying the third filter criterion -After selection of User-defined uint8

Ø At operator the option equals must be selected - this is also the default
option.

Ø For Value there are two input fields. The left of these is dedicated for
decimal inputs, the right one for hexadecimal inputs.Enter the value 255
in the left (decimal) input field.

Figure 111: Specifying the third filter criterion - Input of the value of Ethernet frame, byte
offset 15

Ê As soon as a valid value has been entered, the red frames around the
mandatory input fields Value are displayed in grey.
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Ø Specify the offset of the byte within the Ethernet-Frameto be used for
comparison, here the byte with offset 15.

Figure 112: Specifying the third filter criterion - Input of the offset

Ø Here, you may write an optional comment into the input field Comment,
for instance Message type: Poll response.

ð Now the dialog looks like this.

Figure 113: Specifying the third filter criterion (with Wireshark trace)
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Now the fourth filter criterion must be specified.
Ø In order to specify the third filter criterion Byte at Offset 16 of the

Ethernet Frames equals 1, again click at the Symbol .
Ê Another box for specifying a filter criterion appears.

Figure 114: Specifying the fourth filter criterion - Entering the filter condition

Ø Below type select User-definedt uint8.

Figure 115: Specifying the fourth filter criterion - Selection of User-defined uint8
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Ê After the selection, the dialog looks as follows:

Figure 116: Specifying the fourth filter criterion - After selection of User-defined uint8

Ø At operator the option equals must be selected - this is also the default
option.

Ø For Value there are two input fields. the left of these is dedicated for
decimal inputs, the right one for hexadecimal inputs.

Ê As soon as a valid value has been entered, the red frames around the
mandatory input fields Value are displayed in grey.

Ø Specify the offset of the byte within the Ethernet-Frame to be used for
comparison, here the byte with offset 16.
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Ø Here, you may write an optional comment into the input field Comment,
for instance Source 1 (Controlled Node.

ð Now the dialog looks as follows.

Figure 117: Specifying the flurth filter criterion - (with Wireshark trace)

If you want to analyze the frames more precisely, you may view these using
the Frame Quicktesters.

To open the Frame Quicktester, click at the small arrow right of the text
Open Frame Quicktester un the upper right corner of the dialog. The
dialog is then enlarged by the area of the Frame Quicktester. The controls
of the Frame Quicktester are self-explaining if clicking at the i-signs within a
circle adjacent to these controls. When doing so, additional explanatory
texts about the controls are displayed.
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Ø Click at Next.
Ê The third page of the dialog Edit custom-vslue filters is opened.

Figure 118: Custom-value filters - Specifications for extracting the values out of the acquired
frames

On this page specifications for the extraction of data values from selected
incoming Ethernet frames can be made.

I.e. here it can be defined how a certain value is assigned to each incoming
Ethernet-Frame , which can subsequently be displayed in the Live View or
postprocessed by OPC UA or Node-RED, for instance.

The reaction to incoming Ethernet frames of a certain selected type can be
defined using the following approaches to extraction:
Method Line of action
Event extraction Only an event to be counted occurs indicating the occuremce of the

selected frame type.An explicite assignment of a value to the frame
does not happen. For instance, this approach allows counting the
number of incoming frames fulfilling a certain filter condition.

Value extraction Each incoming Ethernet frame is assigned a certain value by
analysis of the frame contents using defined rules.

Table 16: Custom-value Filters – Approaches to extraction
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In order to define these rules for the value extraction, the following
parameters can be specified for this approach:
Parameter Meaning
Variable type The variable type of the value to be determined

The selection possibilities include the type „Boolean“, various bit
types and string types, unsigned and signed integer types and
floating-point types.

Unit The unit assigned to the value to be determined (optional
specification)

Byte order This parameter decides whether the byte order shall be swapped or
not.

Length in bits The length of the value to be determined, specified as number of bits.
The extraction
position.

This specification allows to decide from which position within the
frame the byte offset is counted. The possible options are:

· Ethernetframe

· Ethernet payload

· TCP payload

· UDP payload
Byte offset The byte offset. It specifies the first byte to be extracted relative to

the extraction position, i.e.how many bytes after the start (or before
the end) of the extraction position the extraction begins

Bit offset The bit offset. It specifies how many bitsafter the start (or before the
end) of the first byte to be evaluatted within the Ethernet frame the
extraction begins. The range of values extends from 0 to 7.

Counting direction
for offset

Indicates the direction into which the byte offset works: Bytes after
the beginning or before the end of the extraction position. The
possible options are:

· From the beginning

· From the end
Table 17: Custom-value Filters – Parameters for extraction and their meaning

Ø Click at Next.
Ê The fourth page of the dialog Edit custom-value filters is opened now:

Figure 119: Custom-value filters – Specification for normalization of acquired data
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On this page you can enter specifications for normalization of the acquired
data values. During normalization the data value is multiplied with a ficxed
factor and then a fixed offset is added to the product. Whether this
clculation occurs and which values the scale factor and the offset should
have, can be specified on this dialog page.

The fields within the dialog Edit custom-value filter have the following
meaning:

Type

Select the normalization type of the list here. 
If the option None is chosen, the values Scale and Offset are set to 0 and
thus no normalization of the measured data takes place. Otherwise, it is
possible to perform a custom-defined normalization based on the fields
Factor and Offset.
During this normalization, the original value is first multiplied with the
specified scale factor and then the offset is added to the intermediate
result.

Scale

Specify the factor Scale for the user-defined normalization here:

Offset

Specify the offset for the user-defined normalization here:
Ø Click at Finish in order to display the configured variable in your project.
ð The entered configuration data for the variable are stored within the

project.
Ø Click at Finish.
ð The custom-value filter just having been defined is stored.
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4.5.5 Step 5 - Signal configuration
To activate the filter, proceed as follows:
Ø Within the Passive Fieldbus Configurator, drag the signal from the

element list window into the window „Signal configuration“.
ð In the window Signal configuration of the Passive Fieldbus

Configurator, a new entry with the name of the filter (in the example
Detect Powerlink-Framesis displayed. By checking By checking the
checkbox, you can separately determine for each single filter, whether
the acquired data shall be fetched from the Edge Gateway by OPC-UA
or transferred into the cloud by Node-RED. whether the acquired data
shall be fetched from the Edge Gateway by OPC UA or made available
within Node-RED.

ð The entry with the name of the custom-value filter within the element list
still remains there, but now it is protected against editing and erasure,
i.e. the respective context menu functions are grayed out and
deactivated.

Figure 120: Window "Signal configuration" of the Passive Fieldbus Configurator.

ð Finally, the configuration of the custom-value filters has been
completed.

Note:
In order to reduce CPU time and memory consumption on the Edge
Gateway only choose those methods for continuation of data
processing, which you really need in your specific application.
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4.5.6 Step 6 - Check Signals in the Live-Data View
This step is optional. Viewing signals within a live-data window is
recommended if you want to check whether a specific signal has been
configured correctly .

Proceed as follows:
Ø Drag all signals intended to be viewed in the window Live Data one by

one with the mouse button pressed down from the element list into the
right part Buckets of the Live Data window.

Ê The data acquisition within the Passive Fieldbus Configurator has been
started. In the Live View window you can watch the signals and tune
your configuration if necessary.

4.5.7 Step 7 - Storing the generated configuration file
Ø Create a configuration file (i.e. project file) for your project using the

Passive Fieldbus Configurator. Store this file via Project > Save within
the main menu before finishing working with the Passive Fieldbus
Configurator .

ð You have now created a project file for the configuration of your network
within the passive mode of the Edge Gateway. In section Uploading the
project file to the Edge Gateway [} page 113] is described, how you can
upload this file to the Edge Gateway and activate it there.
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4.6 Uploading the project file to the Edge Gateway
In the following it is assumed that the Edge Gateway is set to the passive
mode of operation and to configuration mode.

To upload the project file from the PC running the Passive Fieldbus
Configurator lto the Edge Gateway and commission it there, a new network
connection to the Edge Gateway must be present.

To do so, the following actions are required:
1. Opening the configuration page within the Control Panel
2. Only when using OPC UA:

Adjust OPC UA settings like server name or timeout time
3. Upload of configuration into the Edge Gateway
4. Start of passive data acquisition

In detail, proceed as follows:
Ø Open the Control Panel in the window of a Web Browser such as

Microsoft Internet Explorer, Firefox or Google Chrome,.
Ø Within the Control Panel select menu entry Network>Field.
Ê The configuration page for the operation mode of the Edge Gateway in

the Control Panel is opened.

Figure 121: Passive mode of operation - Config mode

The OPC UA configuration is only required on demand and can be left out if
exclusively using Node-RED:
Ø Specify the name of the OPC-UA Server to be applied in the field

Server name.
Ø Additionally configure the Timeout time for transactions in field

Transaction timeout.
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Figure 122: OPC UA configuration (Figure only shows a part)

Ø Confirm the changes in the OPC UA configuration by clicking at "Save
changes".

Ê All specifications required for the configuration of the Edge Gateway
have now been entered completely. In order to make the signal
configuration file effective, it has to be transferred to the Edge Gateway.

Ø To transfer the selected configuration into the Edge Gateway, click at
Upload.

Figure 123: Button "Upload" in the signal configuration area of the configuration page in
the control panel

Ê A dialog for selcting the project file is displayed.
Ø Select the project file generated by the Passive Fieldbus Configurator

within previous step (File type *.fbcfg)
Ê After your selection the project file is transferred to the Edge Gateway.

However, the data acquisition has not yet been started.
Ø To activate the data acquisition, switch to the Operational Mode.
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Figure 124: Switching to operational mode in passive mode of operation

Ê A dialog window appears and informs about the OPC UA Server being
activated and no further changes in configuration being applicable.

Figure 125: Dialog window displayed when switching into the Operational Mode of the
Passive Mode.

Ø At the confirmation prompt answer with Yes.
ð The OPC-UA Server and the „passive fieldbus“ node of Node-RED are

restarted. The passive data acquisition according to the configured
settings and the currently active Node-RED flow begins.

The configured signals are then continued to be processed according to the
setting in window „Signalkonfiguration“ :
· Any arbitrary OPC UA client can access all signals for which the

checkbox OPC UA has been checked in the signal configuration. Also
see OPC UA Client reads process data from Edge
Gateway [} page 122]

· The passivefieldbus node can access all signals for which the
checkbox Node-Node-RED has been checked in the signal
configuration, for instance in order to transfer data to the cloud..
See Node-RED transfers process data into the Cloud [} page 126].
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4.7 Error handling
The following error situations may occur when working with the assive
Fieldbus Configurator:

Error message "No connection to the Edge Gateway" at assignment
of IP address.

If an error message that no connection to the Edge Gateway could be
established is received during the assignment of the IP address, then check
the following topics and repeat the assignment.

1. Is the Edge Gateway switched on and is it connected to the IT- and OT-
networks?

2. Has the Edge Gate3way been switched to the passive mode of
operation?

3. Has the Edge Gateway been switched to configuration mode. 
In mode Operation no assignment is possible.

4. Has the correct IP address been entered?
5. Is the used driver version of the Passive Fieldbus Configurators the

most current one?

If question (2) or question (3) have been answered with "No", proceed as
follows in order to solve the problem:
Ø Invoke the Control Panel and select the menu Network > Field there.
Ø Select the passive mode of operation at Operating mode.
Ø At Passive Mode select „Configuration“.
Ø Repeat the assignment.
ð Now the assignment of the IP address should beperformed

successfully.

Error message during loading the GSDML file.

If an error occurs during reading the GSDML file, the following error
message appears:

Figure 126: Error message "Parsing error in..."
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In this case check the GSDML file for correctness and evaluate the
additional information concerning the error which might be shown in the
output window of the Passive Fieldbus Configurator.

Error message when loading the ENI file

If an error occurs during reading the ENI file, the following error message
appears:

Figure 127: Error message "failed to load ENI file"

In this case check the ENI file for correctness and evaluate the additional
information concerning the error which might be shown in the output
window of the Passive Fieldbus Configurator.

Error message: GSDML file already exists

If the follwoing message appears during reading in the PROFINET device
description file:

Figure 128: GSDML file already exists

The selected GSDML file is already loaded.
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Error message in order to prevent overwriting existing elements

If the following message appears when reading the EtherCAT device
decription file:

Figure 129: Overwriting of existing elements

An EtherCAT network information file (ENI file) has already been loaded.
· If you click at "Ja", this already existing ENI file will be overwritten by the

selected ENI file.
· If you click at "Nein", the currently loaded ENI file will be preserved.

Error message if a module with same slot number is already present

If the following message should occur when creating PROFINET modules:

Figure 130: A module with same slot number already exists!

Check, whether the correct slot number is in use as a slot with the specified
number already exists.
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Error message if a module with same subslot number is already
present

If the following message should occur when creating PROFINET
submodules:

Figure 131: A submodule with same subslot number already exists!

Check, whether the correct subslot number is in use as a subslot with the
specified number already exists.

Process data invisible when importing an ENI file generated by
Codesys

When exporting ENI files from Codesys, it may happen that the exported
ENI file does not match the actual network configuration. Specifically, other
logical bus addresses are exported into the ENI file, than the ones actually
used by the Codesys PLC. Possibly incorrect address assignments for your
variables can be manually edited in netANALYZER Scope. Thus, the
incorrect address can be replaced by the correct address (the changes are
stored in the .fbcfg project and are only necessary once).

Figure 132: Wireshark example for Codesys ENI-Import
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You can observe which address the Codesys PLC actually uses during real
network communication by getting the addresses from a Wireshark trace.

In the following it is assumed that the Edge Gateway is set to the passive
mode of operation and to configuration mode.

To upload the project file from the PC running the Passive Fieldbus
Configurator lto the Edge Gateway and commission it there, a new network
connection to the Edge Gateway must be present.
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5 Further processing of the process data

5.1 Overview
In the Edge Gateway, the received process data can be analyzed,
processed, provided or sent to another device. The following table contains
an overview about the possibilities for further processing of the process
data.
Further processing Description
OPC UA An OPC UA Client reads the process data from the Edge Gateway.

Which process data is provides via OPC UA has to be configured
with the netIOT Passive Fieldbus Configurator.
Section OPC UA Client reads process data from Edge
Gateway [} page 122] describes the selection of signals and uses
an example to show the configuration of an OPC UA Client.

Node-RED The passivefieldbus node in Node-RED receives the process data.
These can be processed within Node-RED and then be sent into a
Cloud. Configure the netIOT Passive Fieldbus Configurator which
process data is to be processed in Node-RED.
Section Node-RED transfers process data into the
Cloud [} page 126] describes further processing of process data
with Node-RED.

Docker container An application in a Docker container can access the raw data of the
fieldbus interface and process these data. For further details, see
section Using a Docker container to access to the raw
data [} page 132].
In this mode, the Edge Gateway does not need a signal
configuration by netIOT Passive Fieldbus Configurator.

Table 18: Possibilities for further processing of the process data
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5.2 OPC UA Client reads process data from Edge Gateway
A possibility to access the data acquired by the Edge Gateway is
transferring these via the OPC UA protocol to a PC executing an OPC UA
Client.

Note:
However, access via OPC UA is only applicable for slowly changing
signals such as temperatures or switches. The achievable
resolution amounts approximately 5 changes per second.

The following example explains the OPC UA-based access to the data
acquired by the Edge Gateway in the passive mode.

5.2.1 Selecting signals for OPC UA
You have to select the signals for OPC UA with the netIOT Passive
Fieldbus Configurator. Check OPC UA in the Signal Configuration
window for signals that the OPC UA Server in the Edge Gateway should
provide.

Figure 133: Selecting signals for OPC UA
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5.2.2 Example: Access to the Edge Gateway over OPC UA using the
Client UA Expert

Prerequisites

This example uses the OPC UA-Client UA Expert from Unified Automation
(http://www.unified-automation.com). Fulfill the following conditions in
order to access the current data of the Edge Gateway via the UA Expert:
1. UA Expert must have been installed.
2. The Edge Gateway is currently in the passive mode of operation and

the mode Operational is active.

Approach

Proceed as follows:
Ø Start the UA Expert.

Figure 134: Intro screen of OPC UA Client UA Expert
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Ø Specify the Server URL of the OPC UA Server of the Edge Gateway. In
UA Expert, open the context menu of entry Project>Servers in window
Project using the right mouse button, usually the left upper window.

Figure 135: Context menu of the UA Expert

Ø Select entry Add.
Ê The window Add Server is opened in UA Expert.

Figure 136: Dialog Add Server in UA Expert
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Ø Click at the entry Double click to Add Server below Custom
Discovery.

Ê The dialog box Enter Url is opened:

Figure 137: Dialog box Enter Url in UA Expert

Ø The Server URL to be entered into this dialog box can be taken from the
page Network>Field of the Control Panel. This URL is structured as
follows:
opc.tcp://<IP-Address>:<OPC UA Port>

Ø In order to close the dialog box, click at Ok.
Ê The dialog box is closed.
Ø In order to close the window Add Server click at Ok.
ð The window is closed. The window Address Space displays an object-

oriented data model within a tree-structure. There, you find the
configuration tree of the Passive Fieldbus Configurator below entry
Root>Objects>passivefieldbus. Below this entry, all process data are
listed which have been taken over into the signal configuration within
the Passive Fieldbus Configurator and for which the respective
checkbox OPC UA has been checked.

ð In the window Data Access View of the UA Expert, the process data
are displayed in „live mode“ and regularly updated.

If you should receive the error message Bad Certification Trust , this
message is caused by the use of the self-signed certificate stored within the
Edge Gateway in its state of delivery.

You have two possibilities to react:
1. Recommended solution: Install an own certificate instead of the self-

signed one from the delivery state of the Edge Gateway.
2. Alternative solution:You can also just ignore the message Bad

Certification Trust. Although the message text states the opposite, there
is really no danger in using the self-signed cerificate provided by
Hilscher.

Note:
Concerning this topic read the notes at the following link Secure
connection.
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5.3 Node-RED transfers process data into the Cloud
The acquired data can also be transferred to Node-RED instead of an OPC
UA-Client. By its flexibility, Node-RED offers a multitude of possibilities for
post-processing the acquired data.

Note:
The access via Node-RED allows processing highly dynamic
process values, for instance from processes in drive technology, as
each value is acquired with a precise time-stamp according to the
current cycle.

When designing the Node-RED flow, use the node passivefieldbus in
order to access the data.

5.3.1 Selecting signals for Node-RED
You have to select the signals for Node-RED with the netIOT Passive
Fieldbus Configurator. Check Node-RED in the Signal Configuration
window for signals for further processing in Node-RED.

Figure 138: Selecting signals for Node-RED

5.3.2 The input node "passivefieldbus"
The input node "passivefieldbus" is used in a similar way as the
fieldbus input node "fieldbus". It allows you to receive data from the
Real-Time Ethernet network in the passive mode of the Edge Gateway.
The following condition must be fulfilled: These data to be received must be
checked within the signal configuration.

The input node "passivefieldbus" just like the Edge Gateway in the
passive mode only works in one direction: it only delivers data, but it cannot
receive any data.
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Configuration

Figure 139: Edit passive fieldbus node

At the configuration of the node passivefieldbus, the following
parameters must be specified:
Parameter Default Meaning
Name passive

fb1
Specify the name of the passivefieldbus node here.

Update
interval

1000 Specify the time interval of the passivefieldbus node in
units of the milliseconds here after which the
passivefieldbus node is read out.

Table 19: Parameters for the configuration of node passivefieldbus:

Considerations concerning the update interval

The minimum applicable value amounts 200 ms. We recommend to use a
value of about some seconds in order to avoid a frame buffer overflow of
the Edge Gateway and consequential data drops.

Example Access to the passivefieldbus node via the debug node

The following example shows how you can access the data delivered by
the input node "passivefieldbus" . It uses the input node
passivefieldbus together with a debug node.

The input node passivefieldbus has to receive data from the Edge-
Gateway. The debug node is used to display these data in the register card
Debug in the edge bar of Node-RED.

Prerequisites

The following prerequisites have to be met:
1. A connection to the Edge Gateway has been established (see section

Using the web browser to establish a connection with the Edge
Gateway):

2. The Node-RED workspace is open.
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Step-by-step instructions

Reproduce this example as follows in Node-RED:

1. Insert input node "passivefieldbus" within the Node-RED workspace
area:
Ø Pull an input node "passivefieldbus" from the node library and

insert it into the worksheet.
Ê The input node passivefieldbus is displayed.

Ê

2. Open bar at the right edge
Ø Open the bar at the right edge with the key combination Ctrl+Space

or via the Node-RED menu View>Show Sidebar
Ø Click at register card Info of the bar at the right edge
Ø Click at the input node passivefieldbus in order to display its properties

and function description in register card Info.

3. Edit input node "passivefieldbus":
Ø Open the edit window by double-clicking at the input node

passivefieldbus.
Ê The edit window for specifying the parameters is displayed.

Figure 140: Edit window for specifying the parameters.

4. Specify the name
Ø Specify a node name for Name. The default name is passive fb1.

5. Specify the update interval
Ø Specify the desired update interrval here. The default value amounts to

1000 ms.

6. Complete fieldbus input node
Ø Click at Done.
Ê The configuration of the input node passivefieldbus is now

completed.
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7. Insert debug node
Ø Pull a debug node out of the node library and insert it to the worksheet.

8. Connect nodes
Ø Connect the fieldbus with the "Debug" node by dragging a line from the

output connector of the fieldbus node to theinput connector of the debug
node.

Deploy
Ø Click at Deploy in order to transfer the nodes still only existing in the

editor to the Edge Gateway and to activate those there.
ð The data flow within the Edge Gateway is activated.

Every time the update interval passes again, the input node
"passivefieldbus" periodically delivers new data, the variable
msg.payload of the debug node is updated with new values. You can
display these in register card Debug of the bar at the right edge of the
Node-RED window.

5.3.3 Structure of the data delivered by the input node
The data delivered from the input node to the debug node (Variable
msg.payload) are delivered as an array of process variables.

Each process variable i.e. each element of this array
· represents an object in JSON notation
· corresponds to a checked variable of the Node-RED signal

configuration (see Step 6 - Signal configuration [} page 37]).

In the following, two objects are shown as example:
[
{
"valueList": [
{
"ts": "1508346006127776395",
"val": 104,
"state": "valid"
},
{
"ts": "1508346006129766435",
"val": 56,
"state": "valid"
},
{
"ts": "1508346006131767355",
"val": 104,
"state": "valid"
},
{
"ts": "1508346006133801555",
"val": 32,
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"state": "valid"
}
],
"name": "et200sp.AQ 4xU/I ST V1.0.AQ 4xU/I ST V1.0.O-channel 0",
"datatype": "INTEGER16"
},
{
"valueList": [
{
"ts": "1508346006127776395",
"val": 1,
"state": "valid"
},
{
"ts": "1508346006129766435",
"val": 1,
"state": "valid"
},
{
"ts": "1508346006131767355",
"val": 0,
"state": "valid"
},
{
"ts": "1508346006133801555",
"val": 0,
"state": "valid"
}
],
"name": "et200sp.DQ 8x24VDC/0.5A ST V1.0.DQ 8x24VDC/0.5A ST
V1.0.Outputs.Bit 0.0",
"datatype": "BIT1"
}
]

Structure of the process variables

The following table explains the structure of the elements of the JSON
array representing the process variables:
Variable Meaning
ValueList Value list containing the acquired data values of the process
Name Name of the array element
Datatype Datatype of the acquired process data values

Table 20: Structure of the process variables (Elements of JSON array)

The number of values in the value list ValueList can be computed as
follows:

Example: If the cycle time of the process data acquisition amounts 2 ms
and the update interval is set to the default value of 1000 ms, then the list
within ValueList contains 1000 : 2 = 500 values. For each of these
values, the following structure is present (see below)
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Structure of the elements of the value list ValueList

The value list stored in ValueList has the following structure:
Name Meaning Explanation
ts Timestamp Time specification with nanosecond precision. It is stored in the UNIX

timestamp format, i.e. it contains the number of nanoseconds since
1970/01/01.

val Data value The process data values are stored and process in the datatype
which has been specified at Datatype (at the array element).

status Status Status of the measured value (binary).
Bit set (Valid). Value is valid
Bit not set (Invalid): Value is invalid

Table 21: Structure of the elements of the value list

5.3.4 Display of data processing status
Node-RED also shows the current status of data processing. The following
status values are defined:
Status Meaning
recording Datá are being recorded

This status only appears, if the Edge Gateway is in the passive mode and is
in state Operational.

disconnected No Connection.
This status is displayed, if no data are acquired, for instance in case of the
Edge Gateway just being in configuration mode.

Dropped
data

Data loss by overflow of the internal ring data buffer within the Edge
Gateway or by too slow processing of the data in Node-RED.

Table 22: Status of data processing in Node-RED
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5.3.5 Adjusting the timing in order to prevent data loss
The following timing diagram explains the causes of possible data loss:

Figure 141: Example: Timing diagram

To prevent data loss during Node-RED-based data processing, take care of
the following two causes:
1. The JSON data are read out in the distance in time specified by the

update interval. If data processing in Node-RED lasts too long so that it
is not yet finished after the update intervall has passed, the complete
data acquired within the affected update intervall are rejected.

2. In the Edge Gateway, there is a 100 MB ring buffer continuously storing
incoming frames and overwriting the oldest frames. An overflow of this
100 MB ring buffer in the Edge Gateway can cause data loss. If data
losses occur (Status Dropped data), at least all data of the affected
update interval are rejected in any case.

Apply these remedies against data loss:
1. Reduce the amount of data within the ring buffer by decreasing either

the update interval or the amount of data to transferred to Node-RED.
2. Optimize the Node-RED-Flow for reduced processing time

5.4 Using a Docker container to access to the raw data
The libpcap library allows you to access the raw data of the passive
fieldbus interface within a Docker container.

Prerequisites
1. The NIOT-E-LIC-SNIF license must be installed on the Edge Gateway,

in order to use the Passive Operation Mode. Section Which licenses are
present in the device? [} page 25] describes how can display available
licenses.

2. In the Control Panel (Control Panel > Field), Operation mode passive
and the Passive mode Docker has to be set.

3. Use the libpcap library, create and load a Docker container into the
Edge Gateway. An example for Docker including documentation is
hosted in the Docker hub repository. The URL is:
https://hub.docker.com/r/hilschernetiotedge/passive-fieldbus/
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6 Performance considerations

6.1 Only use a single passivefieldbus node

Note:
Per Node-RED flow, always only use a single passivefieldbus
node! Defining multiple passivefieldbus node in one Node-RED
flow will strongly deteriorate the performance!
If you should need access to the data provided by the
passivefieldbus node at other locations in the Node-RED flow,
then you should work with a link node in order to provide the
desired data access.
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7 Appendix

7.1 Legal notes

Copyright

© Hilscher Gesellschaft für Systemautomation mbH

All rights reserved.

The images, photographs and texts in the accompanying materials (in the
form of a user's manual, operator's manual, Statement of Work document
and all other document types, support texts, documentation, etc.) are
protected by German and international copyright and by international trade
and protective provisions. Without the prior written consent, you do not
have permission to duplicate them either in full or in part using technical or
mechanical methods (print, photocopy or any other method), to edit them
using electronic systems or to transfer them. You are not permitted to make
changes to copyright notices, markings, trademarks or ownership
declarations. Illustrations are provided without taking the patent situation
into account. Any company names and product designations provided in
this document may be brands or trademarks by the corresponding owner
and may be protected under trademark, brand or patent law. Any form of
further use shall require the express consent from the relevant owner of the
rights.

Important notes

Utmost care was/is given in the preparation of the documentation at hand
consisting of a user's manual, operating manual and any other document
type and accompanying texts. However, errors cannot be ruled out.
Therefore, we cannot assume any guarantee or legal responsibility for
erroneous information or liability of any kind. You are hereby made aware
that descriptions found in the user's manual, the accompanying texts and
the documentation neither represent a guarantee nor any indication on
proper use as stipulated in the agreement or a promised attribute. It cannot
be ruled out that the user's manual, the accompanying texts and the
documentation do not completely match the described attributes, standards
or any other data for the delivered product. A warranty or guarantee with
respect to the correctness or accuracy of the information is not assumed.

We reserve the right to modify our products and the specifications for such
as well as the corresponding documentation in the form of a user's manual,
operating manual and/or any other document types and accompanying
texts at any time and without notice without being required to notify of said
modification. Changes shall be taken into account in future manuals and do
not represent an obligation of any kind, in particular there shall be no right
to have delivered documents revised. The manual delivered with the
product shall apply.

Under no circumstances shall Hilscher Gesellschaft für Systemautomation
mbH be liable for direct, indirect, ancillary or subsequent damage, or for
any loss of income, which may arise after use of the information contained
herein.
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Liability disclaimer

The hardware and/or software was created and tested by Hilscher
Gesellschaft für Systemautomation mbH with utmost care and is made
available as is. No warranty can be assumed for the performance or
flawlessness of the hardware and/or software under all application
conditions and scenarios and the work results achieved by the user when
using the hardware and/or software. Liability for any damage that may have
occurred as a result of using the hardware and/or software or the
corresponding documents shall be limited to an event involving willful intent
or a grossly negligent violation of a fundamental contractual obligation.
However, the right to assert damages due to a violation of a fundamental
contractual obligation shall be limited to contract-typical foreseeable
damage.

It is hereby expressly agreed upon in particular that any use or utilization of
the hardware and/or software in connection with
· Flight control systems in aviation and aerospace;
· Nuclear fusion processes in nuclear power plants;
· Medical devices used for life support and
· Vehicle control systems used in passenger transport

shall be excluded. Use of the hardware and/or software in any of the
following areas is strictly prohibited:
· For military purposes or in weaponry;
· For designing, engineering, maintaining or operating nuclear systems;
· In flight safety systems, aviation and flight telecommunications systems;
· In life-support systems;
· In systems in which any malfunction in the hardware and/or software

may result in physical injuries or fatalities.

You are hereby made aware that the hardware and/or software was not
created for use in hazardous environments, which require fail-safe control
mechanisms. Use of the hardware and/or software in this kind of
environment shall be at your own risk; any liability for damage or loss due
to impermissible use shall be excluded.

Warranty

Hilscher Gesellschaft für Systemautomation mbH hereby guarantees that
the software shall run without errors in accordance with the requirements
listed in the specifications and that there were no defects on the date of
acceptance. The warranty period shall be 12 months commencing as of the
date of acceptance or purchase (with express declaration or implied, by
customer's conclusive behavior, e.g. putting into operation permanently).

The warranty obligation for equipment (hardware) we produce is 36
months, calculated as of the date of delivery ex works. The aforementioned
provisions shall not apply if longer warranty periods are mandatory by law
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a
(1) BGB [Bürgerliches Gesetzbuch; German Civil Code] If, despite of all
due care taken, the delivered product should have a defect, which already

Edge Gateway NIOT-E-TIJCX-GB-RE | Passive Operating Mode
DOC180201UM01EN | Revision 1 | English | 2018-04 | Released | Public

© Hilscher 2018



Appendix 136/143

existed at the time of the transfer of risk, it shall be at our discretion to
either repair the product or to deliver a replacement product, subject to
timely notification of defect.

The warranty obligation shall not apply if the notification of defect is not
asserted promptly, if the purchaser or third party has tampered with the
products, if the defect is the result of natural wear, was caused by
unfavorable operating conditions or is due to violations against our
operating regulations or against rules of good electrical engineering
practice, or if our request to return the defective object is not promptly
complied with.

Costs of support, maintenance, customization and product care

Please be advised that any subsequent improvement shall only be free of
charge if a defect is found. Any form of technical support, maintenance and
customization is not a warranty service, but instead shall be charged extra.

Additional guarantees

Although the hardware and software was developed and tested in-depth
with greatest care, Hilscher Gesellschaft für Systemautomation mbH shall
not assume any guarantee for the suitability thereof for any purpose that
was not confirmed in writing. No guarantee can be granted whereby the
hardware and software satisfies your requirements, or the use of the
hardware and/or software is uninterruptable or the hardware and/or
software is fault-free.

It cannot be guaranteed that patents and/or ownership privileges have not
been infringed upon or violated or that the products are free from third-party
influence. No additional guarantees or promises shall be made as to
whether the product is market current, free from deficiency in title, or can be
integrated or is usable for specific purposes, unless such guarantees or
promises are required under existing law and cannot be restricted.

Confidentiality

The customer hereby expressly acknowledges that this document contains
trade secrets, information protected by copyright and other patent and
ownership privileges as well as any related rights of Hilscher Gesellschaft
für Systemautomation mbH. The customer agrees to treat as confidential all
of the information made available to customer by Hilscher Gesellschaft für
Systemautomation mbH and rights, which were disclosed by Hilscher
Gesellschaft für Systemautomation mbH and that were made accessible as
well as the terms and conditions of this agreement itself.

The parties hereby agree to one another that the information that each
party receives from the other party respectively is and shall remain the
intellectual property of said other party, unless provided for otherwise in a
contractual agreement.

The customer must not allow any third party to become knowledgeable of
this expertise and shall only provide knowledge thereof to authorized users
as appropriate and necessary. Companies associated with the customer
shall not be deemed third parties. The customer must obligate authorized
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users to confidentiality. The customer should only use the confidential
information in connection with the performances specified in this
agreement.

The customer must not use this confidential information to his own
advantage or for his own purposes or rather to the advantage or for the
purpose of a third party, nor must it be used for commercial purposes and
this confidential information must only be used to the extent provided for in
this agreement or otherwise to the extent as expressly authorized by the
disclosing party in written form. The customer has the right, subject to the
obligation to confidentiality, to disclose the terms and conditions of this
agreement directly to his legal and financial consultants as would be
required for the customer's normal business operation.

Export provisions

The delivered product (including technical data) is subject to the legal
export and/or import laws as well as any associated regulations of various
countries, especially such laws applicable in Germany and in the United
States. The products / hardware / software must not be exported into such
countries for which export is prohibited under US American export control
laws and its supplementary provisions. You hereby agree to strictly follow
the regulations and to yourself be responsible for observing them. You are
hereby made aware that you may be required to obtain governmental
approval to export, reexport or import the product.

Terms and conditions

Please read the notes about additional legal aspects on our netIOT web
site under http://www.netiot.com/netiot/netiot-edge/terms-and-
conditions/.
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